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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on
a hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description

Product Name HP EliteBook 8740w Mobile Workstation

Processors Intel® Quad Core™ processors (support Intel Turbo Boost Technology):

● Intel Quad Core i7-940XM Extreme 2.13-GHz processor, 8-MB L2 cache, 8 threads (55W)

● Intel Quad Core i7-920XM Extreme 2.00-GHz (turbo up to 3.20-GHz) processor, 8-MB L2
cache, 8 threads (55W)

● Intel Quad Core i7-840QM 1.86-GHz processor, 8-MB L2 cache, 8 threads (45W)

● Intel Quad Core i7-820QM 1.73-GHz (turbo up to 3.06-GHz) processor, 8-MB L2 cache, 8
threads (45W)

● Intel Quad Core i7-740QM 1.73-GHz processor, 6-MB L2 cache, 8 threads (45W)

● Intel Quad Core i7-720QM 1.66-GHz (turbo up to 2.80-GHz) processor, 6-MB L2 cache, 8
threads (45W)

 Intel Dual Core processors (support Intel Turbo Boost Technology):

● Intel Dual Core i7-640M 2.80-GHz (turbo up to 3.46-GHz) processor, 4-MB L2 cache, 4 threads
(35W)

● Intel Dual Core i7-620M 2.66-GHz (turbo up to 3.33-GHz) processor, 4-MB L2 cache, 4 threads
(35W)

● Intel Dual Core i5-580M 2.66-GHz (turbo up to 3.33-GHz) processor, 3-MB L2 cache, 4 threads
(35W)

● Intel Dual Core i5-560M 2.66-GHz (turbo up to 3.20-GHz) processor, 3-MB L2 cache, 4 threads
(35W)

● Intel Dual Core i5-540M 2.53-GHz (turbo up to 3.06-GHz) processor, 3-MB L2 cache, 4 threads
(35W)

● Intel Dual Core i5-520M 2.40-GHz (turbo up to 2.93-GHz) processor, 3-MB L2 cache, 4 threads
(35W)

Chipset Intel QM57 (Ibex peak enhanced PCH)

Graphics Support for the following graphics subsystem graphics boards (all feature OpenGL driver support):

● ATI Broadway FirePro M7820 XT-GL with 1-GB GDDR5 memory

● nVidia Quadro 5000M N10E-GLM5 with 2-GB GDDR5 memory

● nVidia Quadro FX 2800M N10E-GLM with 1-GB GDDR3 memory

● nVidia Quadro FX 3800M N10E-GLM3 with 1-GB GDDR3 memory
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Category Description

Panel All display assemblies include 3 wireless local area network (WLAN) antenna cables and 2 wireless
wide area network (WWAN) antenna cables

● 17.0-in, WUXGA WVA AntiGlare DreamColor2 with webcam

● 17.0-in, WUXGA WVA AntiGlare DreamColor2 without webcam

● 17.0-in WXGA+ light-emitting diode (LED) with webcam

● 17.0-in WXGA+ LED without webcam

● 17.0-in WSXGA+ WVA LED with webcam

● 17.0-in WSXGA+ WVA LED without webcam

● 17.0-in WUXGA WVA LED with webcam

● 17.0-in WUXGA WVA LED without webcam

Supports privacy filter

Supports 16:10 aspect ratio panels

Memory 4 customer-accessible/upgradable memory module slots

 Supports dual-channel memory

 Supports up to 16,384 GB of system RAM

 DDR3 1333-MHz, PC3-10600

 1333-MHz bus speed on computer models equipped with Quad Core processors

1066-MHZ bus speed on computer models equipped with Dual Core processors

 Supports the following configurations:

● 16384-MB total system memory (4096 × 4); only available on computer models equipped with a
Quad Core processor and a 64-bit operating system)

● 12288-MB total system memory (4096 × 2 + 2048 × 2); only available on computer models
equipped with a Quad Core processor and a 64-bit operating system)

● 8192-MB total system memory (2048 × 4); only available on computer models equipped with a
Quad Core processor and a 64-bit operating system)

● 8192-MB total system memory (4096 × 2); only available on computer models equipped with a
64-bit operating system)

● 4096-MB total system memory (2048 × 2)

● 4096-MB total system memory (4096 × 1)

● 2048-MB total system memory (2048 × 1)

Hard drives and
solid-state drive

Supports 9.5-mm (2.5-in) hard drives

 Customer-accessible

 Serial ATA

 Accelerometer (HP Mobile Data Protection System 3D) RAID 0/1 Support
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Category Description

 Supports the following 7200-rpm drives:

● 640 GB

● 500 GB

● 320 GB

● 250 GB

 Supports 9.5-mm (2.5-in), 256-GB solid-state drive

Optical drives Fixed (removal of 1 screw required)

 Customer-accessible

 Serial ATA

 12.7-mm tray load

 Supports the following drives:

● Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive

● Blu-ray ROM DVD±RW SuperMulti Double-Layer LightScribe Drive

● DVD±RW SuperMulti Double-Layer LightScribe Drive

● DVD-ROM Drive

Upgrade bay Supports 9.5-mm (2.5-in) hard drives

 Customer-accessible

 Serial ATA

 Supports the following 7200-rpm drives:

● 640 GB

● 500 GB

Diskette drive Supports external USB diskette drive only

 Supports boot from external USB diskette drive

Audio and video Integrated dual-array microphones

 IDT 92HD75B high-definition (HD) audio

 Supports 2 stereo speakers

 Integrated 2.0-megapixel webcam with macro focus for business card reader

Modem 56K V.92 1.5-inch data/fax modem

 Supports “no modem” option

 Modem cable not included

Ethernet Intel 82577-LM 10/100/1000 GB network interface card (NIC) with iAMT 6.0 support

 S3/S4/S5 wake on LAN: DC - no

 S3/S4/S5 wake on LAN: AC - yes

 NIC power-down technology
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Category Description

 Ethernet cable not included

Wireless Integrated wireless local area network (WLAN) options by way of wireless module:

 Three WLAN antennas built into display assembly

 Support for no WLAN option

 Support for the following WLAN formats:

● Intel Centrino Advanced-N 6200 802.11a/g/n WLAN module

● Intel Centrino Advanced-N 6200 802.11a/b/g WLAN module (for use only in Russia and the
Ukraine)

● Intel Centrino Ultimate-N 6300 802.11a/g/n WLAN module

● Broadcom 802.11a/b/g/n 2x2 WLAN module

 Integrated wireless wide area network (WWAN) options by way of wireless module:

 Two WWAN antennas built into display assembly (world-wide, 5-band)

 Support for no WWAN option

 Supports WWAN after market option

 Security provided by Subscriber Identify Module (SIM) located inside battery bay

 Support for the following WWAN formats:

● HP un2420 HSPA EV-DO Broadband Module

● HP hs2330 HSPA F3607 900-MHz Mobile Broadband Module

● HP hs2320 HSPA F3607 850-MHz Mobile Broadband Module

 Integrated personal area network (PAN) options by way of Bluetooth® module:

 Support for no-WPAN option

 Broadcom Bluetooth

External media card One ExpressCard slot, supporting 16-bit and 32-bit (Cardbus) ExpressCard modules

 One Digital Media Reader slot, supporting the following optional formats:

● Memory Stick

● Memory Stick Duo

● Memory Stick Pro

● MultiMediaCard

● Secure Digital (SD) Memory Card

● xD-Picture Card

● xD-Picture Card Type H

● xD-Picture Card Type M
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Category Description

Ports ● 1394a

● 3-pin AC power

● Audio-in (mono microphone)

● Audio-out (stereo headphone)

● DisplayPort

● Docking

● eSATA

● RJ-11 (modem)

● RJ-45 (Ethernet, includes link and activity lights)

● USB 3.0 (2)

● USB 2.0 (2)

● VGA (Dsub 15-pin) supporting 1600 × 1200 external resolution at 75-GHz (hot plug/unplug with
auto-detect)

Docking HP 3-in-1 NAS Docking Station, HP Advanced Docking Station, and HP Docking Station

Keyboard/pointing
devices

36.5 cm (14.4-in) keyboard with separate numeric keypad

Dual point (pointing stick and TouchPad) with 3 pointing stick buttons and 3 TouchPad buttons and
vertical scrolling (taps enabled as default)

 Spill-resistant DuraPad coating on TouchPad

 TouchPad gesture support (disabled by default)

Power requirements 230-W and 200-W AC adapters with localized cable plug support (3-wire plug with ground pin,
supports 3-pin DC connector)

 Support for the following batteries:

● 8-cell, 2.55-Ah (73-Wh) Li-ion battery

● 8-cell, 2.55-Ah (68-Wh) Li-ion battery

● 8-cell Extended Life Battery

● 12-cell Ultra Capacity Battery

Security Integrated fingerprint reader

Integrated Smart Card reader (active)

Preboot authentication (password, Smart Card, biometric)

Security cable slot

Trusted platform module (TPM) v.1.2
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Category Description

Operating system Preinstalled:

● Windows® 7 Home Premium 64

● Windows 7 Professional 32/64

● Windows Vista® Home Basic (Service Pack 2)

● Windows XP Professional with Windows 7 Professional license

● FreeDOS

 Preinstalled with Microsoft® Office (not supported in Japan):

● Windows 7 Professional 32/64 with Office Ready

● Windows Vista Business 32 with Office Ready

● Windows XP Professional (Service Pack 3 with Office 2007 Ready (with Windows 7
Professional COA)

 Restore media:

● Office Ready Restore DVD

● Windows 7 Home Basic

● Windows 7 Home Premium 32/64

● Windows 7 Professional 32/64

● Windows 7 DRDVD

● Windows 7 DRDVD with WinDVD

● Windows Vista Business 32

● Windows Vista DRDVD

● Windows XP Professional 32/64

● Windows XP Professional DRDVD

 Supported:

● Microsoft WHQL

● Novell

 Web-only support:

● Windows Vista Business 64

● Windows Vista Enterprise 32/64

● Windows XP Professional 64

6 Chapter 1   Product description



2 External component identification

Display components

Item Component Description

(1) Internal display switch Turns off the display and initiates Sleep (in Windows
7 and Windows Vista) or Standby (in Windows XP) if
the display is closed while the power is on.

NOTE: The internal display switch is not visible from
the outside of the computer.

(2) Internal microphones (2) Record sound.

NOTE: If there is a microphone icon next to each
microphone opening, your computer has internal
microphones.

Display components 7



Item Component Description

(3) Webcam light (select models only) On: The webcam is in use.

(4) Webcam (select models only) Records audio and video and captures still
photographs.

Wireless antenna locations

Item Component Description

(1) WWAN antennas (2)* (select models only) Send and receive wireless signals to communicate
with wireless wide-area networks (WWANs).

(2) WLAN antennas (3)* (select models only) Send and receive wireless signals to communicate
with wireless local area networks (WLANs).

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately
around the antennas free from obstructions.
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Buttons, switches, and fingerprint reader

Item Component Description

(1) Power button ● When the computer is off, press the button to
turn on the computer.

● When the computer is on, press the button to
shut down the computer.

● When the computer is in the Sleep state (in
Windows 7 and Windows Vista) or Standby state
(in Windows XP), press the button briefly to exit
the Sleep state (in Windows 7 and Windows
Vista) or Standby state (in Windows XP.

● When the computer is in Hibernation, press the
button briefly to exit Hibernation. If the computer
has stopped responding and Windows shutdown
procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off
the computer.

To learn more about your power settings:

● In Windows 7 – select Start > Control Panel >
System and Security > Power Options.

● In Windows Vista – select Start > Control Panel
> System and Maintenance > Power Options.

● In Windows XP – select Start > Control Panel >
Performance and Maintenance > Power
Options.

Buttons, switches, and fingerprint reader 9



Item Component Description

(2) QuickLook button ● When the computer is off, press the button to
open HP QuickLook.

● When the computer is on, press the button to
open Software Setup.

NOTE: If Software Setup is not available, the
default Web browser opens.

(3) Internal display switch Turns off the display and initiates Sleep (in Windows
7 and Windows Vista) or Standby (in Windows XP if
the display is closed while the power is on.

NOTE: The internal display switch is not visible from
the outside of the computer.

(4) QuickWeb button ● When the computer is off, press the button to
open HP QuickWeb.

● When the computer is on, press the button to
open the default Web browser.

(5) Wireless button Turns the wireless feature on or off but does not
establish a wireless connection.

NOTE: A wireless network must be set up in order
to establish a wireless connection.

(6) TouchPad button Turns the TouchPad on or off.

(7) Caps lock button Turns caps lock on or off.

(8) Num lock button Turns num lock on or off.

(9) Volume mute button Mutes and restores speaker sound.

(10) Volume down button Decreases speaker volume.

(11) Volume up button Increases speaker volume.

(12) Calculator button Turns on the Windows calculator function.

(13) Fingerprint reader (select models only) Allows a fingerprint logon to Windows, instead of a
password logon.
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Keys

Item Component Description

(1) esc key Displays system information when pressed in
combination with the fn key.

(2) fn key Executes frequently used system functions when
pressed in combination with a function key or the esc
key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the
pointer.

(5) Integrated numeric keypad keys Can be used like the keys on an external numeric
keypad.

(6) Function keys Execute frequently used system functions when
pressed in combination with the fn key.
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Pointing device components

Item Component Description

(1) Pointing stick* Moves the pointer and selects or activates items on
the screen.

(2) Center pointing stick button* Functions like the center button on an external
mouse.

(3) Right pointing stick button* Functions like the right button on an external mouse.

(4) TouchPad scroll zone Scrolls up or down.

(5) Right TouchPad button* Functions like the right button on an external mouse.

(6) Center TouchPad button* Functions like the center button on an external
mouse.

(7) Left TouchPad button* Functions like the left button on an external mouse.

(8) TouchPad* Moves the pointer and selects or activates items on
the screen.

(9) Left pointing stick button* Functions like the left button on an external mouse.

*This table describes factory settings. To view or change pointing device preferences:

● In Windows 7 – select Start > Devices and Printers. Then, right-click the device representing your computer, and
select Mouse settings

● In Windows Vista – select Start > Control Panel > Hardware and Sound > Mouse.

● In Windows XP – select Start > Control Panel > Printers and Other Hardware > Mouse.
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Front components

Item Component Description

(1) Wireless light ● Blue: An integrated wireless device, such as a
WLAN device, the HP Mobile Broadband
Module, and/or a Bluetooth device, is on.

● Amber: All wireless devices are off.

(2) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state (in
Windows 7 and Windows Vista) or Standby state
(in Windows XP).

● Blinking rapidly: An AC adapter with a higher
power rating should be connected.

● Off: The computer is off or in Hibernation.

(3) Battery light ● Amber: A battery is charging.

● Turquoise: A battery is close to full charge
capacity.

● Blinking amber: A battery that is the only
available power source has reached a low
battery level. When the battery reaches a critical
battery level, the battery light begins blinking
rapidly.

● Off: If the computer is plugged into an external
power source, the light turns off when all
batteries in the computer are fully charged. If the
computer is not plugged into an external power
source, the light stays off until the battery
reaches a low battery level.

(4) Drive light ● Blinking turquoise: The hard drive or optical
drive is being accessed.

● Amber: HP 3D DriveGuard has temporarily
parked the internal hard drive, and if present, the
hard drive in the Upgrade bay.

(5) Business card slot Holds a business card in position so that the webcam
can capture an image.

(6) Speakers (2) Produce sound.
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Item Component Description

(7) Audio-out (headphone) jack Produces sound when connected to optional powered
stereo speakers, headphones, ear buds, a headset,
or television audio.

NOTE: When a device is connected to the
headphone jack, the computer speakers are disabled.

(8) Audio-in (microphone) jack Connects an optional computer headset microphone,
stereo array microphone, or monaural microphone.

(9) Media Card Reader Supports the following optional digital card formats:

● Memory Stick

● Memory Stick Duo

● Memory Stick Pro

● MultiMediaCard

● SD Memory Card

● xD-Picture Card

● xD-Picture Card Type H

● xD-Picture Card Type M

(10) Display release button Opens the computer.

Right-side components

Item Component Description

(1) eSATA port Connects high-performance eSATA components,
such as an eSATA external hard drive.

(2) 3.0 SuperSpeed USB ports (2) Connect optional USB devices and transfer data at a
higher speed than a 2.0 USB device.

(3) USB port Connects an optional USB device.

(4) Upgrade bay Supports an optical drive or a hard drive.

(5) RJ-45 (network) jack Connects a network cable.

(6) RJ-11 (modem) jack Connects a modem cable (select models only).
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Left-side components

Item Component Description

(1) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from
being mishandled or stolen.

(2) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to
cool internal components and prevent overheating. It
is normal for the internal fan to cycle on and off during
routine operation.

(3) Power connector Connects an AC adapter.

(4) DisplayPort Connects an optional digital display device such as a
high-performance monitor or projector.

(5) External monitor port Connects an external VGA monitor or projector.

(6) USB port Connects an optional USB device.

(7) 1394 port Connects an optional IEEE 1394 or 1394a device,
such as a camcorder.

(8) ExpressCard slot Supports optional ExpressCards.

(9) Smart Card reader Supports optional Smart Cards and Java™ Cards.

Rear component

The vent enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool internal components and prevent
overheating. It is normal for the internal fan to cycle on and off during routine operation.
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Bottom components

Item Component Description

(1) Battery release latch Releases the battery from the battery bay.

(2) Battery bay Holds the battery.

(3) Docking connector Connects an optional docking device.

(4) Vents (5) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to
cool internal components and prevent overheating. It
is normal for the internal fan to cycle on and off during
routine operation.

(5) Memory module/wireless module compartment Contains the memory module slots, a WWAN module,
and a WLAN module (select models only).

CAUTION: To prevent an unresponsive system,
replace the wireless module only with a wireless
module authorized for use in the computer by the
governmental agency that regulates wireless devices
in your country or region. If you replace the module
and then receive a warning message, remove the
module to restore computer functionality, and then
contact technical support through Help and Support.

(6) Bluetooth module compartment (select models only) Contains a Bluetooth device.

(7) Hard drive bay Holds the hard drive.
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Item Component Description

(8) Accessory battery connector Connects an optional accessory battery.

(9) SIM slot (select models only) Contains a wireless SIM. The SIM slot is located
inside the battery bay.
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3 Illustrated parts catalog

Service tag
When ordering parts or requesting information, provide the computer serial number and model
number provided on the service tag.

Item Component Description

(1) Product name This is the product name affixed to the front of the
computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to each
product.

(3) Part number/Product number (p/n) This number provides specific information about the
product’s hardware components. The part number helps
a service technician determine what components and
parts are needed.
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Item Component Description

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model description This is the alphanumeric identifier used to locate
documents, drivers, and support for the computer.

Service tag 19



Computer major components
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Item Description Spare part number

(1) Display assembly (includes display panel cable, 3 WLAN antenna transceivers and cables, and 2 WWAN antenna
transceivers and cables):

 17.0-in, WUXGA WVA AntiGlare DreamColor2 display with webcam 595709-001

 17.0-in, WUXGA WVA AntiGlare DreamColor2 display without webcam 595705-001

 17.0-in, WUXGA WVA AntiGlare LED display assembly with webcam 595708-001

 17.0-in, WUXGA WVA AntiGlare LED display assembly without webcam 595704-001

 17.0-in, WSXGA+ WVA AntiGlare LED display assembly with webcam 595707-001

 17.0-in, WSXGA+ WVA AntiGlare LED display assembly without webcam 595703-001

 17.0-in, WXGA+ WVA AntiGlare LED display assembly with webcam 595706-001

 17.0-in, WXGA+ WVA AntiGlare LED display assembly without webcam 595702-001

 NOTE: See Display components on page 27 for more display component information and spare part numbers.

(2) Switch cover (includes capacitive board and cable and power button board and cable) 596045-001

(3) Keyboard with backlight (includes keyboard cable, pointing stick and pointing stick cable):

 For use in Belgium 597581-A41

 For use in Bulgaria 597581-261

 For use in Denmark 597581-081

 For use in Finland and Sweden 597581-B71

 For use in France 597581-051

 For use in French Canada 597581-121

 For use in Germany 597581-041

 For use in Greece 597581-DJ1

 For use in Hungary 597581-211

 For use in Iceland 597581-DD1

 For use in Israel 597581-BB1

 For use in Italy 597581-061

 For use in Japan 597581-291

 For use in Latin America 597581-161

 For use in the Netherlands 597581-B31

 For use in Norway 597581-091

 For use in Portugal 597581-131

 For use in Russia 597581-251

 For use in Saudi Arabia 597581-171

 For use in Slovakia 597581-231

 For use in Slovenia 597581-BA1
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 For use in South Korea 597581-AD1

 For use in Spain 597581-071

 For use in Switzerland 597581-111

 For use in Taiwan 597581-AB1

 For use in Thailand 597581-281

 For use in Turkey 597581-141

 For use in the United Kingdom 597581-031

 For use in the United States 597581-001

 Keyboard without backlight (includes cable, pointing stick, and pointing stick cable):

 For use in Belgium 597582-A41

 For use in Brazil 1597582-201

 For use in the Bulgaria 597582-221

 For use in Denmark 597582-081

 For use in Finland and Sweden 597582-B71

 For use in France 597582-051

 For use in French Canada 597582-121

 For use in Germany 597582-041

 For use in Greece 597582-DJ1

 For use in Hungary 597582-211

 For use in Iceland 597582-DD1

 For use in Israel 597582-BB1

 For use in Italy 597582-061

 For use in Japan 597582-291

 For use in Latin America 597582-161

 For use in the Netherlands 597582-B31

 For use in Norway 597582-091

 For use in Portugal 597582-131

 For use in Russia 597582-251

 For use in Saudi Arabia 597582-171

 For use in Slovakia 597582-231

 For use in Slovenia 597582-BA1

 For use in South Korea 597582-AD1

 For use in Spain 597582-071

 For use in Switzerland 597582-BG1
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 For use in Taiwan 597582-AB1

 For use in Thailand 597582-281

 For use in Turkey 597582-141

 For use in the United Kingdom 597582-031

 For use in the United States 597582-001

(4) Memory modules (4, PC3-10600, 1333-MHz, DDR3):  

 8192-MB memory module 634091-001

 4096-MB memory module 599092-001

 2048-MB memory module 598856-001

(5) Graphics board heat sink (includes replacement thermal material):

 For use only with computer models equipped with ATi graphics subsystems (includes 5
replacement thermal pads)

596046-001

 For use only with computer models equipped with nVidia graphics subsystems (includes
replacement thermal pads and thermal paste)

597571-001

(6) Fan 596047-001

(7) Graphics board (includes replacement thermal material):

 ATi XT-GL graphics board with 1-GB GDDR4 memory 596061-001

 nVidia GLM5 graphics board with 2-GB GDDR5 memory 596064-001

 nVidia GLM3 graphics board with 1-GB GDDR3 memory 596063-001

 nVidia GLM3 graphics board with 1-GB GDDR3 memory 596062-001

 Plastics Kit, includes: 596044-001

(8a) ExpressCard slot bezel

(8b) Memory module/wireless module compartment cover (includes 3 captive screws, secured by C-clips)

(8c) Bluetooth module compartment cover

(8d) Hard drive cover (includes 2 captive screws, secured by C-clips)

 NOTE: See Plastics Kit on page 31 for more Plastics Kit spare part information.

 Cable Kit, includes: 596040-001

(9a) Bluetooth module cable

(9b) Modem module cable (includes RJ-11 jack)

(9c) Audio cable

(9d) Network cable (includes RJ-45 jack)

 NOTE: See Cable Kit on page 26 for more Cable Kit spare part information.

(10) Processor heat sink (includes replacement thermal material):

 For use only with computer models equipped with Quad Core processors 597570-001

 For use only with computer models equipped with Dual Core processors 596048-001
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(11) Processor(includes replacement thermal material):

 Intel Quad Core i7-940XM Extreme 2.13-GHz processor, 8-MB L2 cache, 8 threads, 55W 619342-001

 Intel Quad Core i7 920XM Extreme 2.00-GHz (turbo up to 3.20-GHz) processor, 8-MB L2
cache, 8 threads, 55-W

590663-001

 Intel Quad Core i7-840QM 1.86-GHz processor, 8-MB L2 cache, 8 threads, 45W 612260-001

 Intel Quad Core i7 820QM 1.73-GHz (turbo up to 3.06-GHz) processor, 8-MB L2 cache, 8
threads, 45-W

583053-001

 Intel Quad Core i7-740QM 1.73-GHz processor, 6-MB L2 cache, 8 threads, 45W 612259-001

 Intel Quad Core i7 720QM 1.66-GHz (turbo up to 2.80-GHz) processor, 8-MB L2 cache, 8
threads, 45-W

586170-001

 Intel Dual Core i7-640M 2.80-GHz (turbo up to 3.46-GHz) processor, 4-MB L2 cache, 4
threads, 35W

625826-001

 Intel Dual Core i7 620M 2.66-GHz (turbo up to 3.33-GHz) processor, 4-MB L2 cache, 4
threads, 35-W

587259-002

 Intel Dual Core i5-580M 2.66-GHz (turbo up to 3.33-GHz) processor, 3-MB L2 cache, 4
threads, 35W

625825-001

 Intel Dual Core i5-560M 2.66-GHz (turbo up to 3.20-GHz) processor, 3-MB L2 cache, 4
threads, 35W

625824-001

 Intel Dual Core i5 540M 2.53-GHz (turbo up to 3.06-GHz) processor, 3-MB L2 cache, 4
threads, 35-W

594188-002

 Intel Dual Core i5 520M 2.40-GHz (turbo up to 2.93-GHz) processor, 3-MB L2 cache, 4
threads, 35-W

594187-002

(12) Top cover (includes pointing stick buttons and cable, and TouchPad and cable)

NOTE: The fingerprint reader and cable are available using spare part number
607815-001.

597580-001

(13) Audio board (includes Digital Media slot and cable) 596055-001

(14) Speaker assembly 494029-001

(15) Modem module:

NOTE: The modem module spare part kit does not include a modem module cable. The modem module cable is
included in the Cable Kit, spare part number 596040-001.

 For use in all countries and regions except Australia and New Zealand 510099-001

 For use only in Australia and New Zealand 510099-011

(16) USB board 597572-001

(17) System board (includes replacement thermal material)

 For use in all countries and regions except the People's Republic of China and Russia:

 ● For use with computer models equipped with Intel Quad Core processors 595700-001

 ● For use with computer models equipped with Intel Dual Core processors 595698-001

 For use only in the People's Republic of China and Russia:

 ● For use with computer models equipped with Intel Quad Core processors 598446-001
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 ● For use with computer models equipped with Intel Dual Core processors 598445-001

(18) Base enclosure (includes Smart Card bezel and rubber feet) 596053-001

(19) Battery:

 8-cell, 73-Wh, Li-ion battery 493976-001

 8-cell, 68-Wh, Li-ion battery 592078-001

(20) Optical drive (includes bezel and bracket):

 Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive 606374-001

 DVD±RW SuperMulti Double-Layer LightScribe Drive 606373-001

 Blu-ray ROM DVD±RW SuperMulti Double-Layer LightScribe Drive 606371-001

 DVD-ROM Drive 606372-001

(21) Hard drive carrier 613682-001

(22) WLAN module:

 Intel Centrino Advanced-N 6200 802.11a/g/n WLAN module 572509-001

 Intel Centrino Ultimate-N 6300 802.11a/g/n WLAN module 572511-001

 Intel Centrino Advanced-N 6200 802.11 a/b/g WLAN module (for use only in Russia and
the Ukraine)

572510-001

 Broadcom 802.11a/b/g/n 2x2 WLAN module 582564-001

(23) WWAN module:

 HP hs2330 HSPA F3607 900-MHz Mobile Broadband Module 574249-001

 HP hs2320 HSPA F3607 850-MHz Mobile Broadband Module 574248-001

 HP un2420 HSPA EV-DO Broadband Module 531993-001

(24) RTC battery 449137-001

(25) Bluetooth module

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable.
The Bluetooth module cable is included in the Cable Kit, spare part number 596040-001.

537921-001

(26) Mass storage device

 6.35-cm (2.50-in) hard drive:

NOTE: The hard drive bracket is included in the Hard Drive Hardware Kit, spare part number 630891-001.

 ● 640-GB, 7200-rpm 621046-001

 ● 500-GB, 7200-rpm 634919-001

 ● 320-GB, 7200-rpm 627731-001

 ● 320-GB, 7200-rpm SED (Self-Encrypting Drive) 626978-001

 ● 250-GB, 7200-rpm 538972-001

 256-GB solid-state drive (includes bracket) 596419-001
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Cable Kit

Item Description Spare part number

 Cable Kit: 596040-001

(1) Bluetooth module cable

(2) Audio cable

(3) Modem module cable (includes RJ-11 jack)

(4) Network cable (includes RJ-45 jack)
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Display components

Item Description Spare part number

(1) Display bezel:

 For use only with computer models equipped with a webcam 597579-001

 For use only with computer models not equipped with a webcam 597578-001

(2) Webcam module 596050-001

(3) Microphones 596043-001
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Item Description Spare part number

(4) Ambient light sensor board (includes double-sided tape) 596051-001

(5) Display panel cable (includes webcam module cable and ambient light sensor board
cable)

596042-001

 Display Hinge Kit, includes: 596052-001

(6a) Left and right hinges and brackets

(6b) Left and right hinge covers

 Wireless Antenna Kit, includes: 596041-001

(7a) WLAN antenna transceivers and cables

(7b) WWAN antenna transceivers and cables

(8) Display enclosure (includes logo) 597576-001

 Display Rubber Kit (not illustrated, includes 2 bezel rubber bumpers and 8 rubber screw
covers

596049-001

 Display Screw Kit (not illustrated) 597573-001
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Mass storage devices

Item Description Spare part number

(1) 6.35-cm (2.50-in) hard drive:

NOTE: The hard drive bracket is included in the Hard Drive Hardware Kit, spare part number 630891-001.

 ● 640-GB, 7200-rpm 621046-001

 ● 500-GB, 7200-rpm 634919-001

 ● 320-GB, 7200-rpm 627731-001

 ● 320-GB, 7200-rpm SED (Self-Encrypting Drive) 626978-001

 ● 250-GB, 7200-rpm 538972-001

(2) 6.35-cm (2.50-in) 256-GB solid-state drive (includes bracket) 596419-001

(3) Hard drive carrier 613682-001

(4) Optical drive (includes bezel and bracket)

 Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive 606374-001

 DVD±RW SuperMulti Double-Layer LightScribe Drive 606373-001
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 Blu-ray ROM DVD±RW SuperMulti Double-Layer LightScribe Drive 606371-001

 DVD-ROM Drive 606372-001
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Plastics Kit

Item Description Spare part number

 Plastics Kit: 596044-001

(1) ExpressCard slot bezel

(2) Memory module/wireless module compartment cover (includes one captive screw, secured by a C-clip)

(3) Bluetooth module compartment cover

(4) Hard drive cover (includes 2 captive screws, secured by C-clips)
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Miscellaneous parts
Description Spare part number

AC Adapter

230-W RC/V AC Smart Adapter 613159-001

200-W RC/V AC Smart Adapter 613158-001

Power cord:

For use in Argentina 491683-D01

For use in Australia and New Zealand 491683-011

For use in Brazil 491683-201

For use in Canada and the United States 491683-001

For use in Denmark 491683-081

For use in Europe, the Middle East, and Africa 491683-021

For use in India 491683-D61

For use in Israel 491683-BB1

For use in Italy 491683-061

For use in Japan 491683-291

For use in the People's Republic of China 491683-AA1

For use in South Africa 491683-AR1

For use in South Korea 491683-AD1

For use in Switzerland 491683-111

For use in Taiwan 491683-AB1

For use in the United Kingdom 491683-031

Hard Drive Hardware Kit 630891-001

Screw Kit 596039-001
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Spare part
number

Description

449137-001 RTC battery

491683-001 Power cord for use in Canada and the United States

491683-011 Power cord for use in Australia and New Zealand

491683-021 Power cord for use in Europe, the Middle East, and Africa

491683-031 Power cord for use in Singapore and the United Kingdom

491683-061 Power cord for use in Italy

491683-081 Power cord for use in Norway

491683-111 Power cord for use in Switzerland

491683-201 Power cord for use in Brazil

491683-291 Power cord for use in Japan

491683-AA1 Power cord for use in the People's Republic of China

491683-AB1 Power cord for use in Taiwan

491683-AD1 Power cord for use in South Korea

491683-AR1 Power cord for use in South Africa

491683-BB1 Power cord for use in Israel

491683-D01 Power cord for use in Argentina

491683-D61 Power cord for use in India

493976-001 8-cell, 73-Wh, Li-ion battery

494029-001 Speaker assembly

510099-001 Modem module for use in all countries and regions except Australia and New Zealand

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth
module cable is included in the Cable Kit, spare part number 596040-001.

510099-011 Modem module for use only in Australia and New Zealand

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth
module cable is included in the Cable Kit, spare part number 596040-001.

531993-001 HP un2420 EV-DO Broadband module

537921-001 Bluetooth module

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth
module cable is included in the Cable Kit, spare part number 596040-001.

538972-001 6.35-cm (2.50-in), 250-GB, 7200-rpm hard drive

572509-001 Intel Centrino Advanced-N 6200 802.11a/g/n WLAN module

572510-001 Intel Centrino Advanced-N 6200 802.11 a/b/g WLAN module (for use only in Russia and the Ukraine)

572511-001 Intel Centrino Ultimate-N 6300 802.11a/g/n WLAN module
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574248-001 HP hs2320 HSPA F3607 850-MHz Mobile Broadband Module

574249-001 HP hs2330 HSPA F3607 900-MHz Mobile Broadband Module

582564-001 Broadcom 4322 802.11a/b/g/n 2x2 WLAN module

583053-001 Intel Quad Core i7 820QM 1.73-GHz (turbo up to 3.06-GHz) processor, 8-MB L2 cache, 8 threads, 45-W
(supports Intel Turbo Boost Technology, includes replacement thermal material)

586170-001 Intel Quad Core i7 720QM 1.66-GHz (turbo up to 2.80-GHz) processor, 8-MB L2 cache, 8 threads, 45-W
(supports Intel Turbo Boost Technology, includes replacement thermal material)

587259-002 Intel Dual Core i7 620M 2.66-GHz (turbo up to 3.33-GHz) processor, 4-MB L2 cache, 4 threads, 35-W
(supports Intel Turbo Boost Technology, includes replacement thermal material)

590663-001 Intel Quad Core i7 920XM Extreme 2.00-GHz (turbo up to 3.20-GHz) processor, 8-MB L2 cache, 8 threads,
55-W (supports Intel Turbo Boost Technology, includes replacement thermal material)

592078-001 8-cell, 68-Wh, Li-ion battery

594187-002 Intel Dual Core i5 520M 2.40-GHz (turbo up to 2.93-GHz) processor, 3-MB L2 cache, 4 threads, 35-W
(supports Intel Turbo Boost Technology, includes replacement thermal material)

594188-002 Intel Dual Core i5 540M 2.53-GHz (turbo up to 3.06-GHz) processor, 3-MB L2 cache, 4 threads, 35-W
(supports Intel Turbo Boost Technology, includes replacement thermal material)

595698-001 System board for use with computer models equipped with Intel Dual Core processors in all countries and
regions except the People's Republic of China and Russia: (includes replacement thermal material)

595700-001 System board for use with computer models equipped with Intel Quad Core processors in all countries and
regions except the People's Republic of China and Russia: (includes replacement thermal material)

595702-001 17.0-in, WXGA+ WVA AntiGlare LED display assembly without webcam (includes the display panel cable,
3 WLAN antenna transceivers and cables, and 2 WWAN antenna transceivers and cables)

595703-001 17.0-in, WSXGA+ WVA AntiGlare LED display assembly without webcam (includes the display panel cable,
3 WLAN antenna transceivers and cables, and 2 WWAN antenna transceivers and cables)

595704-001 17.0-in, WUXGA WVA AntiGlare LED display assembly without webcam (includes the display panel cable,
3 WLAN antenna transceivers and cables, and 2 WWAN antenna transceivers and cables)

595705-001 17.0-in, WUXGA WVA AntiGlare DreamColor2 display without webcam (includes the display panel cable, 3
WLAN antenna transceivers and cables, and 2 WWAN antenna transceivers and cables)

595706-001 17.0-in, WXGA+ WVA AntiGlare LED display assembly with webcam (includes the display panel cable, 3
WLAN antenna transceivers and cables, and 2 WWAN antenna transceivers and cables)

595707-001 17.0-in, WSXGA+ WVA AntiGlare LED display assembly with webcam (includes the display panel cable, 3
WLAN antenna transceivers and cables, and 2 WWAN antenna transceivers and cables)

595708-001 17.0-in, WUXGA WVA AntiGlare LED display assembly with webcam (includes the display panel cable, 3
WLAN antenna transceivers and cables, and 2 WWAN antenna transceivers and cables)

595709-001 17.0-in, WUXGA WVA AntiGlare DreamColor2 display with webcam (includes the display panel cable, 3
WLAN antenna transceivers and cables, and 2 WWAN antenna transceivers and cables)

596039-001 Screw Kit

596040-001 Cable Kit

NOTE: See Cable Kit on page 26 for more Cable Kit spare part information.

596041-001 Wireless Antenna Kit (includes WLAN antenna transceivers and cables and WWAN antenna transceivers
and cables)
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596042-001 Display panel cable (includes webcam module cable and ambient light sensor board cable)

596043-001 Microphone

596044-001 Plastics Kit

NOTE: See Plastics Kit on page 31 for more Plastics Kit spare part information.

596045-001 Switch cover (includes capacitive board and cable and power button board and cable)

596046-001 Graphics board heat sink for use only with computer models equipped with ATi graphics subsystems
(includes 5 replacement thermal pads)

596047-001 Fan

596048-001 Processor heat sink for use only with computer models equipped with Dual Core processors (includes
replacement thermal material)

596049-001 Display Rubber Kit (includes 2 bezel rubber bumpers and 6 rubber screw covers

596050-001 Webcam module

596051-001 Ambient light sensor board (includes double-sided tape)

596052-001 Display Hinge Kit (includes left and right hinges and brackets)

596053-001 Base enclosure (includes Smart Card bezel and rubber feet)

596055-001 Audio board (includes Digital Media slot and cable)

596057-001 Smart Card reader

596061-001 ATi XT-GL graphics board with 1-GB GDDR4 memory (includes replacement thermal material)

596062-001 nVidia GLM3 graphics board with 1-GB GDDR3 memory (includes replacement thermal material)

596063-001 nVidia GLM3 graphics board with 1-GB GDDR3 memory (includes replacement thermal material)

596064-001 nVidia GLM5 graphics board with 2-GB GDDR5 memory (includes replacement thermal material)

596419-001 256-GB solid-state drive (includes bracket)

597570-001 Processor heat sink for use only with computer models equipped with Quad Core processors (includes
replacement thermal material)

597571-001 Graphics board heat sink for use only with computer models equipped with nVidia graphics subsystems
(includes replacement thermal pads and thermal paste)

597572-001 USB board (includes cable)

597573-001 Display Screw Kit

597576-001 Display enclosure (includes logo)

597578-001 Display bezel for use only with computer models not equipped with a webcam

597579-001 Display bezel for use only with computer models equipped with a webcam

597580-001 Top cover (includes pointing stick buttons and cable, and TouchPad and cable)

597581-001 Keyboard with backlight for use in Canada and the United States (includes keyboard cable, pointing stick
and pointing stick cable)

597581-031 Keyboard with backlight for use in Singapore and the United Kingdom (includes keyboard cable, pointing
stick and pointing stick cable)
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597581-041 Keyboard with backlight for use in Germany (includes keyboard cable, pointing stick and pointing stick
cable)

597581-051 Keyboard with backlight for use in France (includes keyboard cable, pointing stick and pointing stick cable)

597581-061 Keyboard with backlight for use in Italy (includes keyboard cable, pointing stick and pointing stick cable)

597581-071 Keyboard with backlight for use in Spain (includes keyboard cable, pointing stick and pointing stick cable)

597581-081 Keyboard with backlight for use in Denmark (includes keyboard cable, pointing stick and pointing stick
cable)

597581-091 Keyboard with backlight for use in Norway (includes keyboard cable, pointing stick and pointing stick cable)

597581-121 Keyboard with backlight for use in French Canada (includes keyboard cable, pointing stick and pointing
stick cable)

597581-131 Keyboard with backlight for use in Portugal (includes keyboard cable, pointing stick and pointing stick
cable)

597581-141 Keyboard with backlight for use in Turkey (includes keyboard cable, pointing stick and pointing stick cable)

597581-161 Keyboard with backlight for use in Latin America (includes keyboard cable, pointing stick and pointing stick
cable)

597581-171 Keyboard with backlight for use in Saudi Arabia (includes keyboard cable, pointing stick and pointing stick
cable)

597581-211 Keyboard with backlight for use in Hungary (includes keyboard cable, pointing stick and pointing stick
cable)

597581-251 Keyboard with backlight for use in Russia (includes keyboard cable, pointing stick and pointing stick cable)

597581-261 Keyboard with backlight for use in Bulgaria (includes keyboard cable, pointing stick and pointing stick cable)

597581-281 Keyboard with backlight for use in Thailand (includes keyboard cable, pointing stick and pointing stick
cable)

597581-291 Keyboard with backlight for use in Japan (includes keyboard cable, pointing stick and pointing stick cable)

597581-A41 Keyboard with backlight for use in Belgium (includes keyboard cable, pointing stick and pointing stick cable)

597581-A81 Keyboard with backlight for use in Slovenia (includes keyboard cable, pointing stick and pointing stick
cable)

597581-AB1 Keyboard with backlight for use in Taiwan (includes keyboard cable, pointing stick and pointing stick cable)

597581-AD1 Keyboard with backlight for use in South Korea (includes keyboard cable, pointing stick and pointing stick
cable)

597581-B31 Keyboard with backlight for use in the Netherlands (includes keyboard cable, pointing stick and pointing
stick cable)

597581-B71 Keyboard with backlight for use in Finland and Sweden (includes keyboard cable, pointing stick and
pointing stick cable)

597581-BA1 Keyboard with backlight for use in Slovakia (includes keyboard cable, pointing stick and pointing stick
cable)

597581-BB1 Keyboard with backlight for use in Israel (includes keyboard cable, pointing stick and pointing stick cable)

597581-BG1 Keyboard with backlight for use in Switzerland (includes keyboard cable, pointing stick and pointing stick
cable)

597581-DD1 Keyboard with backlight for use in Iceland (includes keyboard cable, pointing stick and pointing stick cable)

36 Chapter 3   Illustrated parts catalog



Spare part
number

Description

597581-DJ1 Keyboard with backlight for use in Greece (includes keyboard cable, pointing stick and pointing stick cable)

597582-001 Keyboard without backlight for use in Canada and the United States (includes keyboard cable, pointing
stick and pointing stick cable)

597582-031 Keyboard without backlight for use in Singapore and the United Kingdom (includes keyboard cable, pointing
stick and pointing stick cable)

597582-041 Keyboard without backlight for use in Germany (includes keyboard cable, pointing stick and pointing stick
cable)

597582-051 Keyboard without backlight for use in France (includes keyboard cable, pointing stick and pointing stick
cable)

597582-061 Keyboard without backlight for use in Italy (includes keyboard cable, pointing stick and pointing stick cable)

597582-071 Keyboard without backlight for use in Spain (includes keyboard cable, pointing stick and pointing stick
cable)

597582-081 Keyboard without backlight for use in Denmark (includes keyboard cable, pointing stick and pointing stick
cable)

597582-091 Keyboard without backlight for use in Norway (includes keyboard cable, pointing stick and pointing stick
cable)

597582-121 Keyboard without backlight for use in French Canada (includes keyboard cable, pointing stick and pointing
stick cable)

597582-131 Keyboard without backlight for use in Portugal (includes keyboard cable, pointing stick and pointing stick
cable)

597582-141 Keyboard without backlight for use in Turkey (includes keyboard cable, pointing stick and pointing stick
cable)

597582-161 Keyboard without backlight for use in Latin America (includes keyboard cable, pointing stick and pointing
stick cable)

597582-171 Keyboard without backlight for use in Saudi Arabia (includes keyboard cable, pointing stick and pointing
stick cable)

597582-201 Keyboard without backlight for use in Brazil (includes keyboard cable, pointing stick and pointing stick
cable)

597582-211 Keyboard without backlight for use in Hungary (includes keyboard cable, pointing stick and pointing stick
cable)

597582-251 Keyboard without backlight for use in Russia (includes keyboard cable, pointing stick and pointing stick
cable)

597582-261 Keyboard without backlight for use in Bulgaria (includes keyboard cable, pointing stick and pointing stick
cable)

597582-281 Keyboard without backlight for use in Thailand (includes keyboard cable, pointing stick and pointing stick
cable)

597582-291 Keyboard without backlight for use in Japan (includes keyboard cable, pointing stick and pointing stick
cable)

597582-A41 Keyboard without backlight for use in Belgium (includes keyboard cable, pointing stick and pointing stick
cable)

597582-AB1 Keyboard without backlight for use in Taiwan (includes keyboard cable, pointing stick and pointing stick
cable)
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597582-AD1 Keyboard without backlight for use in South Korea (includes keyboard cable, pointing stick and pointing
stick cable)

597582-B31 Keyboard without backlight for use in the Netherlands (includes keyboard cable, pointing stick and pointing
stick cable)

597582-B71 Keyboard without backlight for use in Finland and Sweden (includes keyboard cable, pointing stick and
pointing stick cable)

597582-BA1 Keyboard without backlight for use in Slovakia (includes keyboard cable, pointing stick and pointing stick
cable)

597582-BB1 Keyboard without backlight for use in Israel (includes keyboard cable, pointing stick and pointing stick
cable)

597582-BG1 Keyboard without backlight for use in Switzerland (includes keyboard cable, pointing stick and pointing stick
cable)

597582-DD1 Keyboard without backlight for use in Iceland (includes keyboard cable, pointing stick and pointing stick
cable)

597582-DJ1 Keyboard without backlight for use in Greece (includes keyboard cable, pointing stick and pointing stick
cable)

598445-001 System board for use with computer models equipped with Intel Dual Core processors only in the People's
Republic of China and Russia (includes replacement thermal material)

598446-001 System board for use with computer models equipped with Intel Quad Core processors only in the People's
Republic of China and Russia (includes replacement thermal material)

598856-001 2048-MB memory module (PC3-10600, 1333-MHz, DDR3)

599092-001 4096-MB memory module (PC3-10600, 1333-MHz, DDR3)

606371-001 Blu-ray ROM DVD±RW SuperMulti Double-Layer LightScribe Drive

606372-001 DVD-ROM Drive

606373-001 DVD±RW SuperMulti Double-Layer LightScribe Drive

606374-001 Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive

607815-001 Fingerprint reader (includes cable)

612259-001 Intel Quad Core i7-740QM 1.73-GHz processor, 6-MB L2 cache, 8 threads, 45W (includes replacement
thermal material)

612260-001 Intel Quad Core i7-840QM 1.86-GHz processor, 8-MB L2 cache, 8 threads, 45W (includes replacement
thermal material)

613158-001 200-W RC/V AC Smart Adapter

613159-001 230-W RC/V AC Smart Adapter

613682-001 Hard drive carrier

619342-001 Intel Quad Core i7-940XM Extreme 2.13-GHz processor, 8-MB L2 cache, 8 threads, 55W (includes
replacement thermal material)

621046-001 6.35-cm (2.50-in), 640-GB, 7200-rpm hard drive

625824-001 Intel Dual Core i5-560M 2.66-GHz (turbo up to 3.20-GHz) processor, 3-MB L2 cache, 4 threads, 35W
(supports Intel Turbo Boost Technology, includes replacement thermal material)
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Spare part
number

Description

625825-001 Intel Dual Core i5-580M 2.66-GHz (turbo up to 3.33-GHz) processor, 3-MB L2 cache, 4 threads, 35W
(supports Intel Turbo Boost Technology, includes replacement thermal material)

625826-001 Intel Dual Core i7-640M 2.80-GHz (turbo up to 3.46-GHz) processor, 4-MB L2 cache, 4 threads, 35W
(supports Intel Turbo Boost Technology, includes replacement thermal material)

626978-001 6.35-cm (2.50-in), 320-GB, 7200-rpm SED (Self-Encrypting Drive)

627731-001 6.35-cm (2.50-in), 320-GB, 7200-rpm hard drive

630891-001 Hard Drive Hardware Kit

634091-001 8192-MB memory module (PC3-10600, 1333-MHz, DDR3)

634919-001 6.35-cm (2.50-in), 500-GB, 7200-rpm hard drive
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4 Removal and replacement procedures

Preliminary replacement requirements
Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Magnetic screwdriver

● Phillips P0 and P1 screwdrivers

● Torx T8 screwdriver

● 5.0-mm hex socket driver

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
Using excessive force during disassembly and reassembly can damage plastic parts. Use care when
handling the plastic parts. Apply pressure only at the points designated in the maintenance
instructions.
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Cables and and pointing stick connectors
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to
unseat or seat the cables during removal and insertion. Handle cables by the connector whenever
possible. In all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in
such a way that they cannot be caught or snagged by parts being removed or replaced. Handle flex
cables with extreme care; these cables tear easily.

Drive handling
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated and pointing stick circuits
provide some protection, but in many cases, ESD contains enough power to alter device parameters
or melt silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and and pointing stick can work
perfectly throughout a normal cycle. Or the device may function normally for a while, then degrade in
the internal layers, reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you area ready to install them.

Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines
described in this section.

Avoid touching pins, leads, and and pointing stick circuitry. Handle electronic components as little as
possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand and pointing stick contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved and pointing stick
containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

● Use transporters and and pointing stick conveyors made of antistatic belts and roller bushings.
Be sure that mechanized equipment used for moving materials is wired to ground and that
proper materials are selected to avoid static charging. When grounding is not possible, use an
ionizer to dissipate electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded
tools and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid and pointing stick contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible
straps with a minimum of one megohm ±10% resistance in the ground and pointing stick cords.
To provide proper ground, wear a strap snugly against the skin at all times. On grounded mats
with banana-plug connectors, use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips
must be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground and pointing stick cords of one megohm
resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 98 screws and screw locks that must be removed, replaced, or loosened when
servicing the computer. Make special note of each screw and screw lock size and location during
removal and replacement.

Service tag
When ordering parts or requesting information, provide the computer serial number and model
number provided on the service tag.

Item Component Description

(1) Product name This is the product name affixed to the front of the
computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to each
product.

(3) Part number/Product number (p/n) This number provides specific information about the
product’s hardware components. The part number helps
a service technician determine what components and
parts are needed.

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model description This is the alphanumeric identifier used to locate
documents, drivers, and support for the computer.
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Computer feet
The computer feet are adhesive-backed rubber pads. The feet are included in the base enclosure
spare part kit, spare part number 596053-001. There are 9 rubber feet that attach to the base
enclosure in the locations illustrated below.
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Battery

Description Spare part number

8-cell, 73-Wh, Li-ion battery 493976-001

8-cell, 68-Wh, Li-ion battery 592078-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery:

1. Turn the computer upside down on a flat surface, with the battery bay toward you.

2. Slide the battery release latch (1) to release the battery.

3. Remove the battery (2) from the computer.

Install the battery by inserting it into the battery bay until you hear a click.
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SIM
Before removing the SIM, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47).

Remove the SIM:

1. Press in on the SIM (1) to release it from the SIM slot.

2. Remove the SIM (2) from the SIM slot.

Install the SIM by inserting it into the SIM slot until you hear a click.
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Primary hard drive
NOTE: The hard drive bracket is included in the Hard Drive Hardware Kit, spare part number
630891-001.

Description Spare part number

6.35-cm (2.50-in) 640-GB, 7200-rpm hard drive 621046-001

6.35-cm (2.50-in) 500-GB, 7200-rpm hard drive 634919-001

6.35-cm (2.50-in) 320-GB, 7200-rpm hard drive 627731-001

6.35-cm (2.50-in) 320-GB, 7200-rpm SED (Self-Encrypting Drive) 626978-001

6.35-cm (2.50-in) 250-GB, 7200-rpm hard drive 538972-001

6.35-cm (2.50-in) 256-GB solid-state drive (includes bracket) 596419-001

Before removing the primary hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47).

Remove the primary hard drive:

1. Position the computer with the front toward you.

2. Loosen the two captive Phillips screws (1) that secure the hard drive cover to the computer.
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3. Lift the right side of the hard drive cover (2), swing it up and to the left, and then remove the
cover (3). The hard drive cover is included in the Plastics Kit, spare part number 596044-001.

4. Loosen the captive Phillips screw (1) that secures the hard drive to the computer.

5. Grasp the Mylar tab on the hard drive and slide the hard drive (2) to the left to disconnect it from
the system board.

6. Remove the hard drive (3) from the hard drive bay.

7. If it is necessary to replace the hard drive bracket, remove the four Phillips PM3.0×3.0
screws (1) that secure the bracket to the hard drive.
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8. Lift the bracket (2) straight up to remove it from the hard drive.

Reverse this procedure to reassemble and install the hard drive.
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Bluetooth module
NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The
Bluetooth module cable is included in the Cable Kit, spare part number 596040-001. See Bluetooth
module cable on page 89 for information on replacing the Bluetooth module cable.

Description Spare part number

Bluetooth module 537921-001

Before removing the Bluetooth module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47).

5. Remove the hard drive cover (see Primary hard drive on page 49).

Remove the Bluetooth module:

1. Lift the rear edge of the Bluetooth module compartment cover (1) until it detaches from the base
enclosure.

2. Remove the Bluetooth module compartment cover (2). The Bluetooth module compartment
cover is included in the Plastics Kit, spare part number 596044-001.

3. Release the clip (1) built into the base enclosure that secures the Bluetooth module.

4. Release the Bluetooth module (2) as far as the Bluetooth module cable allows.
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5. Disconnect the Bluetooth module cable (3) from the Bluetooth module.

6. Remove the Bluetooth module.

Reverse this procedure to install the Bluetooth module and Bluetooth module compartment cover.
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Optical drive

Description Spare part number

Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive 606374-001

DVD±RW SuperMulti Double-Layer LightScribe Drive 606373-001

Blu-ray ROM DVD±RW SuperMulti Double-Layer LightScribe Drive 606371-001

DVD-ROM Drive 606372-001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47).

Remove the optical drive:

1. Position the computer with the left side toward you.

2. Loosen the captive Phillips screw (1) that secures the optical drive to the computer.

3. Insert a flat-bladed screwdriver or similar tool into the optical drive tab access (2) and press the
tab to the left to release the optical drive from the computer.

4. Remove the optical drive (3).

5. If it is necessary to replace the optical drive bracket, position the optical drive with the rear
toward you.
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6. Remove the three Phillips PM2.0×4.0 screws (1) that secure the optical drive bracket to the
optical drive.

7. Remove the optical drive bracket (2).

Reverse this procedure to reassemble and install the optical drive.

Secondary hard drive
NOTE: The hard drive bracket is included in the Hard Drive Hardware Kit, spare part number
630891-001.

Description Spare part number

6.35-cm (2.50-in) 640-GB, 7200-rpm hard drive 621046-001

6.35-cm (2.50-in) 500-GB, 7200-rpm hard drive 634919-001

6.35-cm (2.50-in) 320-GB, 7200-rpm hard drive 627731-001

6.35-cm (2.50-in) 320-GB, 7200-rpm SED (Self-Encrypting Drive) 626978-001

6.35-cm (2.50-in) 250-GB, 7200-rpm hard drive 538972-001

Hard drive carrier 613682-001

Before removing the secondary hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47).

Remove the secondary hard drive:

1. Position the computer with the left side toward you.

2. Remove the four Mylar screw covers (1) that conceal the secondary hard drive carrier retention
screws.

3. Remove the four Phillips PM3.0×3.0 screws (2) that secure the secondary hard drive carrier to
the computer.
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4. Loosen the captive Phillips screw (3) that secures the secondary hard drive carrier to the
computer.

5. Insert a flat-bladed screwdriver or similar tool into the secondary hard drive carrier tab access (4)
and press the tab to the left to release the secondary hard drive carrier from the computer.

6. Remove the secondary hard drive (5).

7. Loosen the captive Phillips screw (1) that secures the secondary hard drive to the secondary
hard drive carrier.

8. Use the Mylar tab to lift the front edge of the secondary hard drive (2) until it rests at an angle.

9. Release the secondary hard drive (3) by sliding it up and forward at an angle.

10. Remove the secondary hard drive.

Reverse this procedure to reassemble and install the secondary hard drive and secondary hard drive
carrier.
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WLAN module

Description Spare part number

Intel Centrino Advanced-N 6200 802.11a/g/n WLAN module 572509-001

Intel Centrino Advanced-N 6200 802.11 a/b/g WLAN module (for use only in Russia and the
Ukraine)

572510-001

Intel Centrino Ultimate-N 6300 802.11a/g/n WLAN module 572511-001

Broadcom 802.11a/b/g/n 2x2 WLAN module 582564-001

CAUTION: The WLAN module and the WWAN module are not interchangeable.

To prevent an unresponsive system, replace the wireless module only with a wireless module
authorized for use in the computer by the governmental agency that regulates wireless devices in
your country or region. If you replace the module and then receive a warning message, remove the
module to restore device functionality, and then contact technical support.

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47).

Remove the WLAN module:

1. Position the computer with the front toward you.

2. Loosen the captive Phillips screw (1) that secures the memory module/wireless module
compartment cover to the computer.
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3. Lift the rear edge of the memory module/wireless module compartment cover (2), swing it up
and forward, and then remove the cover (3). The memory module/wireless module compartment
cover is included in the Plastics Kit, spare part number 596044-001.

4. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal.
The white WLAN antenna cable is connected to the WLAN module “Aux” terminal. If there are
three WLAN antenna cables, the yellow WLAN antenna cable is connected to the WLAN module
“3” (or middle) terminal.

5. Remove the two Phillips PM2.0×4.0 screws (2) that secure the WLAN module to the system
board. (The WLAN module tilts up.)

6. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion of the
WLAN module into the WLAN module slot.
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Reverse this procedure to install the WLAN module.

WWAN module

Description Spare part number

HP hs2330 HSPA F3607 900-MHz Mobile Broadband Module 574249-001

HP hs2320 HSPA F3607 850-MHz Mobile Broadband Module 574248-001

HP un2420 EV-DO Broadband module 531993-001

CAUTION: The WWAN module and the WLAN module are not interchangeable.

To prevent an unresponsive system, replace the wireless module only with a wireless module
authorized for use in the computer by the governmental agency that regulates wireless devices in
your country or region. If you replace the module and then receive a warning message, remove the
module to restore device functionality, and then contact technical support.

Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47).

5. Remove the memory module/wireless module compartment cover (see WLAN module
on page 57).

Remove the WWAN module:

1. Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal. The
blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

2. Remove the two Phillips PM2.0×4.0 screws (2) that secure the WWAN module to the system
board. (The WLAN module tilts up.)
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3. Remove the WWAN module (3) by pulling the module away from the slot at an angle.

NOTE: WWAN modules are designed with a notch (4) to prevent incorrect insertion of the
WWAN module into the WWAN module slot.

Reverse this procedure to install the WWAN module.

Expansion memory module

Description Spare part number

8192-MB memory module (PC3-10600, 1333-MHz, DDR3) 634091-001

4096-MB memory module (PC3-10600, 1333-MHz, DDR3) 599092-001

2048-MB memory module (PC3-10600, 1333-MHz, DDR3) 598856-001

NOTE: A memory module must be installed in the right expansion memory module slot before a
memory module is installed in the left expansion memory module slot.

Before removing an expansion memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47).

5. Remove the memory module/wireless module compartment cover (see WLAN module
on page 57).
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Remove an expansion memory module:

1. Spread the retaining tabs (1) on each side of the expansion memory module slot to release the
expansion memory module. (The edge of the module opposite the slot rises away from
the computer.)

2. Remove the expansion memory module (2) by pulling the module away from the slot at an
angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect installation into the
expansion memory module slots.

Reverse this procedure to install an expansion memory module.

Component replacement procedures 61



RTC battery

Description Spare part number

RTC battery 449137-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47).

5. Remove the memory module/wireless module compartment cover (see WLAN module
on page 57).

Remove the RTC battery:

▲ Remove the RTC battery from the socket on the system board.

Reverse this procedure to install the RTC battery. When installing the RTC battery, make sure the “+”
sign faces up.
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Keyboard

For use in: Spare part number For use in: Spare part number

Keyboard with backlight (includes keyboard cable, pointing stick and pointing stick cable):

Belgium 597581-A41 Norway 597581-091

Bulgaria 597581-261 Portugal 597581-131

Denmark 597581-081 Russia 597581-251

Finland and Sweden 597581-B71 Saudi Arabia 597581-171

France 597581-051 Slovakia 597581-231

French Canada 597581-121 Slovenia 597581-BA1

Germany 597581-041 South Korea 597581-AD1

Greece 597581-DJ1 Spain 597581-071

Hungary 597581-211 Switzerland 597581-111

Iceland 597581-DD1 Taiwan 597581-AB1

Israel 597581-BB1 Thailand 597581-281

Italy 597581-061 Turkey 597581-141

Japan 597581-291 The United Kingdom 597581-031

Latin America 597581-161 The United States 597581-001

The Netherlands 597581-B31   

Keyboard without backlight (includes keyboard cable, pointing stick and pointing stick cable):

Belgium 597582-A41 The Netherlands 597582-B31

Brazil 597582-281 Norway 597582-091

Bulgaria 597582-261 Portugal 597582-131

Denmark 597582-081 Russia 597582-251

Finland and Sweden 597582-B71 Saudi Arabia 597582-171

France 597582-051 Slovakia 597582-231

French Canada 597582-121 Slovenia 597582-BA1

Germany 597582-041 South Korea 597582-AD1

Greece 597582-DJ1 Spain 597582-071

Hungary 597582-211 Switzerland 597582-111

Iceland 597582-DD1 Taiwan 597582-AB1

Israel 597582-BB1 Thailand 597582-281

Italy 597582-061 Turkey 597582-141

Japan 597582-291 The United Kingdom 597582-031

Latin America 597582-161 The United States 597582-001
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Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47).

Remove the keyboard:

1. Position the computer with the front toward you.

2. Loosen the three captive Phillips screws that secure the keyboard to the computer.

3. Turn the computer right-side up, with the front toward you.

4. Open the computer as far as it will open.

5. Lift the rear edge of the keyboard (1) until it rests at an angle.

6. Slide the keyboard back (2) until the keyboard cable and pointing stick cable are accessible.
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7. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, and
then disconnect the keyboard cable from the system board.

8. Release the ZIF connector (2) to which the pointing stick cable is attached, and then disconnect
the pointing stick cable from the system board.

9. Remove the keyboard (3).

Reverse this procedure to install the keyboard.
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Primary memory module

Description Spare part number

8192-MB memory module (PC3-10600, 1333-MHz, DDR3) 634091-001

4096-MB memory module (PC3-10600, 1333-MHz, DDR3) 599092-001

2048-MB memory module (PC3-10600, 1333-MHz, DDR3) 598856-001

NOTE: A memory module must be installed in the bottom primary memory module slot before a
memory module is installed in the top primary memory module slot.

Before removing a primary memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47).

5. Remove the keyboard (see Keyboard on page 63).

Remove the primary memory modules:

1. Spread the retaining tabs (1) on each side of the primary memory module slot to release the
primary memory module. (The edge of the module opposite the slot rises away from
the computer.)

2. Remove the primary memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect installation into the
primary memory module slots.
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Reverse this procedure to install a primary memory module.

Switch cover

Description Spare part number

Switch cover (includes capacitive board and cable and power button board and cable) 596045-001

Before removing the switch cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47).

5. Remove the keyboard (see Keyboard on page 63).

Remove the switch cover:

1. Close the computer.

2. Turn the computer upside down, with the rear panel toward you.

3. Turn the computer right-side up, with the front toward you.

4. Open the computer as far as it will open.

5. Remove the three Phillips PM2.0×4.0 broad head screws that secure the switch cover to the
computer.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect installation into the
primary memory module slots.

6. Release the switch cover (1) until it detaches from the computer, and then slide the switch cover
(2) back as far as the capacitive board cable allows.
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7. Release the ZIF connector to which the capacitive board cable is attached, and then disconnect
the cable (3) from the system board.

8. Remove the switch cover.

Reverse this procedure to install the switch cover.
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Graphics board heat sink

Description Spare part number

For use only with computer models equipped with ATi graphics subsystems (includes 5
replacement thermal pads)

596046-001

For use only with computer models equipped with nVidia graphics subsystems (includes
replacement thermal pads and thermal paste)

597571-001

NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-inch) clearance on the left side
of the computer. The computer uses an electric fan for ventilation. The fan is controlled by a
temperature sensor and is designed to turn on automatically when high temperature conditions exist.
These conditions are affected by high external temperatures, system power consumption, power
management/battery conservation configurations, battery fast charging, and software requirements.
Exhaust air is displaced through the ventilation grill located on the left side of the computer.

Before removing the graphics board heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47).

5. Remove the keyboard (see Keyboard on page 63).

6. Remove the switch cover (see Switch cover on page 67).

Remove the graphics board heat sink:

1. Disconnect the fan cable (1) from the system board.

2. Following the 1, 2, 3, 4, 5, 6 sequence stamped into the graphics board heat sink, loosen the six
Phillips captive screws (2) that secure the graphics board heat sink to the system board.

3. Lift the front edge of the graphics board heat sink (3) until it rests at an angle.

NOTE: Due to the adhesive quality of the thermal material located between the graphics board
heat sink and graphics board components, it may be necessary to move the graphics board heat
sink from side to side to detach it from the system board.
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4. Slide the graphics board heat sink (4) up and forward at an angle and remove it.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the graphics
board heat sink and the graphics board each time the graphics board heat sink is removed.
Thermal paste is used on the largest component (1) on the graphics board and the graphics
board heat sink section (2) that services it. Thermal pads and/or thermal paste are used on the
other graphics board components (3) and the graphics board heat sink sections (4) that service
them.

NOTE: Location of the thermal pads and thermal paste may vary.

Reverse this procedure to install the graphics board heat sink.
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Fan
NOTE: The fan spare part kit includes replacement thermal material.

Description Spare part number

Fan 596047-001

Before removing the fan, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47), and then remove the following components:

a. Keyboard (see Keyboard on page 63)

b. Switch cover (see Switch cover on page 67)

c. Graphics board heat sink (see Graphics board heat sink on page 69)

Remove the fan:

1. Turn the graphics board heat sink upside down, with the fan toward you.

2. Remove the three Phillips PM2.0×3.0 screws (1) that secure the fan to the graphics board heat
sink.

3. Remove the fan (2).

Reverse this procedure to install the fan.
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Graphics board
NOTE: The graphics board spare part kit includes replacement thermal material.

Description Spare part number

ATi XT-GL graphics board with 1-GB GDDR4 memory 596061-001

nVidia GLM5 graphics board with 2-GB GDDR5 memory 596064-001

nVidia GLM3 graphics board with 1-GB GDDR3 memory 596063-001

nVidia GLM3 graphics board with 1-GB GDDR3 memory 596062-001

Before removing the graphics board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47), and then remove the following components:

a. Keyboard (see Keyboard on page 63)

b. Switch cover (see Switch cover on page 67)

c. Graphics board heat sink (see Graphics board heat sink on page 69)

Remove the graphics board:

1. Remove the two Phillips PM2.5×4.0 screws (1) that secure the graphics board to the system
board.

2. Lift the rear edge of the graphics board (2) until it rests at an angle.
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3. Slide the graphics board (3) back at an angle.

4. Remove the graphics board.

Reverse this procedure to install the graphics board.

Processor heat sink

Description Spare part number

For use only with computer models equipped with Quad Core processors 597570-001

For use only with computer models equipped with Dual Core processors 596048-001

Before removing the processor heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47), and then remove the following components:

a. Keyboard (see Keyboard on page 63)

b. Switch cover (see Switch cover on page 67)

c. Graphics board heat sink (see Graphics board heat sink on page 69)
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Remove the processor heat sink:

1. Following the 1, 2, 3, 4 sequence stamped into the processor heat sink, loosen the four Phillips
captive screws (1) that secure the processor heat sink to the system board.

2. Lift the right side of the processor heat sink (2) until it rests at an angle.

NOTE: Due to the adhesive quality of the thermal material located between the processor heat
sink and processor, it may be necessary to move the processor heat sink from side to side to
detach it from the system board.

3. Slide the processor heat sink (3) up and to the right at an angle and remove it.

NOTE: Thermal paste located on the surfaces of the processor (1) and processor heat sink (2)
must be thoroughly removed and replaced each time the processor heat sink is removed.
Replacement thermal paste is included in the processor heat sink and processor spare part kits.

Reverse this procedure to install the processor heat sink.
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Processor
NOTE: The processor spare part kit includes replacement thermal material.

Description Spare part number

Intel Quad Core i7-940XM Extreme 2.13-GHz processor, 8-MB L2 cache, 8 threads, 55W 619342-001

Intel Quad Core i7 920XM Extreme 2.00-GHz (turbo up to 3.20-GHz) processor, 8-MB L2 cache, 8
threads, 55-W

590663-001

Intel Quad Core i7-840QM 1.86-GHz processor, 8-MB L2 cache, 8 threads, 45W 612260-001

Intel Quad Core i7 820QM 1.73-GHz (turbo up to 3.06-GHz) processor, 8-MB L2 cache, 8 threads,
45-W

583053-001

Intel Quad Core i7-740QM 1.73-GHz processor, 6-MB L2 cache, 8 threads, 45W 612259-001

Intel Quad Core i7 720Qm 1.66-GHz (turbo up to 2.80-GHz) processor, 8-MB L2 cache, 8 threads,
45-W

586170-001

Intel Dual Core i7-640M 2.80-GHz (turbo up to 3.46-GHz) processor, 4-MB L2 cache, 4 threads,
35W

625826-001

Intel Dual Core i7 620M 2.66-GHz (turbo up to 3.33-GHz) processor, 4-MB L2 cache, 4 threads,
35-W

587259-002

Intel Dual Core i5-580M 2.66-GHz (turbo up to 3.33-GHz) processor, 3-MB L2 cache, 4 threads,
35W

625825-001

Intel Dual Core i5-560M 2.66-GHz (turbo up to 3.20-GHz) processor, 3-MB L2 cache, 4 threads,
35W

625824-001

Intel Dual Core i5 540M 2.53-GHz (turbo up to 3.06-GHz) processor, 3-MB L2 cache, 4 threads,
35-W

594188-002

Intel Dual Core i5 520M 2.40-GHz (turbo up to 2.93-GHz) processor, 3-MB L2 cache, 4 threads,
35-W

594187-002

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47), and then remove the following components:

a. Keyboard (see Keyboard on page 63)

b. Switch cover (see Switch cover on page 67)

c. Graphics board heat sink (see Graphics board heat sink on page 69)

d. Processor heat sink (see Processor heat sink on page 73)
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Remove the processor:

1. Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn
counterclockwise, until you hear a click.

2. Lift the processor (2) straight up and remove it.

NOTE: When you install the processor, the gold triangle (3) on the processor must be aligned
with the triangle (4) embossed on the processor socket.

Reverse this procedure to install the processor.

Display assembly
NOTE: The display assembly spare part kit includes the display panel cable, 3 WLAN antenna
transceivers and cables, and 2 WWAN antenna transceivers and cables.

Description Spare part number

17.0-in, WUXGA WVA AntiGlare DreamColor2 display with webcam 595709-001

17.0-in, WUXGA WVA AntiGlare DreamColor2 display without webcam 595705-001

17.0-in, WUXGA WVA AntiGlare LED display assembly with webcam 595708-001

17.0-in, WUXGA WVA AntiGlare LED display assembly without webcam 595704-001

17.0-in, WSXGA+ WVA AntiGlare LED display assembly with webcam 595707-001

17.0-in, WSXGA+ WVA AntiGlare LED display assembly without webcam 595703-001

17.0-in, WXGA+ WVA AntiGlare LED display assembly with webcam 595706-001

17.0-in, WXGA+ WVA AntiGlare LED display assembly without webcam 595702-001
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Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47).

5. Disconnect the wireless antenna cables from the WLAN module (see WLAN module
on page 57) and the WWAN module (see WWAN module on page 59).

6. Remove the keyboard (see Keyboard on page 63).

7. Remove the switch cover (see Switch cover on page 67).

Remove the display assembly:

1. Close the computer.

2. Turn the computer upside down, with the rear panel toward you.

3. Remove the four Torx T8M2.5×8.0 screws (1) and the Phillips PM2.5×4.0 screw (2) that secure
the display assembly to the computer.

4. Disconnect the display panel cable (1) from the system board.

5. Disconnect the microphone cable (2) from the audio cable.
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6. Release the display panel cable and microphone cable from the clips (3) built into the top cover.

7. Disconnect the webcam cable (1) (when applicable) from the system board.

8. Release the wireless antenna cables (2) from the opening in the system board.
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9. Release the webcam cable (when applicable) and the wireless antenna cables from the clips (3)
built into the top cover.

CAUTION: Support the display assembly when removing the following screws. Failure to
support the display assembly can result in damage to the display assembly and other device
components.

NOTE: When installing the display assembly, be sure the grounded sections of the webcam
cable (1) and wireless antenna cables are securely routed through the clips (2) and routing
channels built into the base enclosure.

10. Remove the two Torx T8M2.5×8.0 screws (1) that secure the display assembly to the computer.
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11. Remove the display assembly (2).

12. If it is necessary to replace the display bezel or any of the display assembly internal
components:

a. Remove the six rubber screw covers (1) that conceal the display bezel screws. The rubber
screw covers are included in the Display Rubber Kit, spare part number 596049-001.

b. Remove the six Torx T8M2.5×8.0 screws (2) that secure the display bezel to the display
assembly.

c. Flex the inside edges of the top edge (1), the left and right sides (2), and the bottom edge
(3) of the display bezel until the bezel disengages from the display enclosure.
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d. Remove the display bezel (4). The display bezel is available using spare part numbers
597579-001 (for use only with computer models equipped with a webcam) and 597578-001
(for use only with computer models not equipped with a webcam).

13. If it is necessary to replace the ambient light sensor board:

a. Remove the Phillips PM2.5×4.0 screw (1) that secures the ambient light sensor board to
the display enclosure.

b. Release the ambient light sensor board (2) as far as the ambient light sensor board cable
allows.

c. Disconnect the display panel cable (3) from the ambient light sensor board.

d. Remove the ambient light sensor board. The ambient light sensor board is available using
spare part number 596051-001.
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14. If it is necessary to replace the hinges and hinge covers:

a. Release the display panel cable and the microphone cable from the display hinge cover on
the display left hinge (1).

b. Release the webcam cable (when applicable) and the wireless antenna cables from the
display hinge cover on the display right hinge (2).

c. Release the display panel cable and the webcam cable (when applicable) from the clips
and routing channel built into the display enclosure (3).

d. Remove the four Torx T8M2.5×6.0 screws (1) that secure the display panel to the display
enclosure.

e. Lift the top edge of the display panel (2) until it rests at an angle.

f. Lift the display panel (3) straight up and remove it.

g. Remove the eight Phillips PM2.0×4.0 screws (1) that secure the hinges to the display
panel.
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h. Remove the hinges (2).

i. Remove the two Phillips PM2.0×4.0 screws (3) that secure the hinge covers to the hinges.

j. Slide the hinge covers (4) toward the middle of the display panel and remove them. The
hinges and hinge covers are included in the Display Hinge Kit, spare part number
596052-001.

15. If it is necessary to replace the display panel cable:

a. Remove the display panel from the display enclosure.

b. Turn the display panel upside down, with the bottom toward you.

c. Release the flap (1) built into the display panel shield.

d. Release the support strip (2) that secures the display panel cable to the display panel.

e. Disconnect the display panel cable (3) from the display panel.
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f. Remove the display panel cable (4). The display panel cable is available using spare part
number 596042-001.

16. If it is necessary to replace the WWAN antenna cables and transceivers:

a. Detach the WWAN antenna transceivers (1) from the display enclosure. The transceivers
are attached to the display enclosure with double-sided tape.

b. Release the WWAN antenna cables from the clips (2) and (3) built into the display
enclosure.

c. Remove the WWAN antenna cables and transceivers. The WWAN antenna cables and
transceivers are available in the Wireless Antenna Kit, spare part number 596041-001.

17. If it is necessary to replace the WLAN antenna cables and transceivers:

a. Detach the WLAN antenna transceivers (1) from the display enclosure. The transceivers
are attached to the display enclosure with double-sided tape.
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b. Release the WLAN antenna cables from the clips (2) and (3) built into the display
enclosure.

c. Remove the WLAN antenna cables and transceivers. The WLAN antenna cables and
transceivers are available in the Wireless Antenna Kit, spare part number 596041-001.

18. If it is necessary to replace the webcam module:

a. Release the webcam module (1) as far from the display enclosure as the webcam module
cable allows.

b. Disconnect the webcam module cable (2) from the webcam module.

c. Remove the webcam module. The webcam module is available using spare part number
596050-001.

19. If it is necessary to replace the microphones:

a. Release the microphone cables from the clips (1) built into the display enclosure.
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b. Release the microphone receivers (2) from the clips built into the display enclosure.

c. Remove the microphone receivers and cables. The microphone receivers and cables are
available using spare part number 596043-001.

Reverse this procedure to install the processor.

Top cover

Description Spare part number

Top cover (includes pointing stick buttons and cable, and TouchPad and cable) 597580-001

Fingerprint reader (includes cable) 607815-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47), and then remove the following components:

a. Optical drive (see Optical drive on page 54) or secondary hard drive (see Secondary hard
drive on page 55)

b. Keyboard (see Keyboard on page 63)

c. Switch cover (see Switch cover on page 67)

d. Display assembly (see Display assembly on page 76)
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Remove the top cover:

1. Turn the computer upside down, with the front toward you.

2. Remove the eleven Torx T8M2.5×8.0 screws (1) that secure the top cover to the base
enclosure.

3. Remove the Phillips PM2.5×4.0 screw (2) that secures the top cover to the base enclosure.

4. Turn the computer right-side up, with the front toward you.

5. Disconnect the TouchPad cable (1) and the fingerprint reader board cable (2) from the system
board.

6. Release the modem module cable (3) from the clips built into the top cover.
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7. Remove the six Phillips PM2.5×6.0 screws that secure the top cover to the base enclosure.

8. Lift the rear edge of the top cover (1) until the left and right sides and the rear edge of the top
cover detach from the base enclosure.

9. Lift the top cover (2) straight up and remove it.

Reverse this procedure to install the top cover.
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Bluetooth module cable
NOTE: The Bluetooth module cable is included in the Cable Kit, spare part number 596040-001.

Before removing the Bluetooth module cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47), and then remove the following components:

a. Optical drive (see Optical drive on page 54) or secondary hard drive (see Secondary hard
drive on page 55)

b. Keyboard (see Keyboard on page 63)

c. Switch cover (see Switch cover on page 67)

d. Display assembly (see Display assembly on page 76)

e. Top cover (see Top cover on page 86)

Remove the Bluetooth module cable:

1. Release the Bluetooth module cable (1) from the opening in the base enclosure.

2. Disconnect the Bluetooth module cable (2) from the system board.

3. Detach the Bluetooth module cable (3) from the base enclosure. The Bluetooth module cable is
attached to the base enclosure with double-sided tape.

4. Remove the Bluetooth module cable.

Reverse this procedure to install the Bluetooth module cable.
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Audio board

Description Spare part number

Audio board (includes Digital Media slot and cable) 596055-001

Before removing the audio board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47), and then remove the following components:

a. Optical drive (see Optical drive on page 54) or secondary hard drive (see Secondary hard
drive on page 55)

b. Keyboard (see Keyboard on page 63)

c. Switch cover (see Switch cover on page 67)

d. Display assembly (see Display assembly on page 76)

e. Top cover (see Top cover on page 86)

Remove the audio board:

1. Remove the two Phillips PM2.5×4.0 screws (1) that secure the audio board to the base
enclosure.

2. Lift the rear edge of the audio board (2) and disconnect it from the system board.

3. Release the audio board (3) from the base enclosure by sliding it toward the back of the base
enclosure.

4. Remove the audio board.
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Reverse this procedure to install the audio board.

Speaker assembly

Description Spare part number

Speaker assembly 494029-001

Before removing the speaker assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47), and then remove the following components:

a. Optical drive (see Optical drive on page 54) or secondary hard drive (see Secondary hard
drive on page 55)

b. Keyboard (see Keyboard on page 63)

c. Switch cover (see Switch cover on page 67)

d. Display assembly (see Display assembly on page 76)

e. Top cover (see Top cover on page 86)

Remove the speaker assembly:

1. Disconnect the speaker assembly cable (1) from the system board.

2. Remove the two Phillips PM2.5×4.0 screws (2) that secure the speaker assembly to the base
enclosure.
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3. Remove the speaker assembly (3).

Reverse this procedure to install the speaker assembly.
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Audio cable
NOTE: The audio cable is included in the Cable Kit, spare part number 596040-001.

Before removing the audio cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47), and then remove the following components:

a. Optical drive (see Optical drive on page 54) or secondary hard drive (see Secondary hard
drive on page 55)

b. Keyboard (see Keyboard on page 63)

c. Switch cover (see Switch cover on page 67)

d. Display assembly (see Display assembly on page 76)

e. Top cover (see Top cover on page 86)

Remove the audio cable:

1. Disconnect the audio cable (1) from the system board.

2. Release the audio cable (2) from the space between the primary memory module slot and the
graphics board slot.

3. Remove the audio cable.

Reverse this procedure to install the audio cable.
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Modem module
NOTE: The modem module spare part kit does not include a modem module cable. The modem
module cable is included in the Cable Kit, spare part number 596040-001. See Modem module cable
on page 95 for information on replacing the modem module cable.

Description Spare part number

For use in all countries and regions except Australia and New Zealand 510099-001

For use only in Australia and New Zealand 510099-011

Before removing the modem module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47), and then remove the following components:

a. Optical drive (see Optical drive on page 54) or secondary hard drive (see Secondary hard
drive on page 55)

b. Keyboard (see Keyboard on page 63)

c. Switch cover (see Switch cover on page 67)

d. Display assembly (see Display assembly on page 76)

e. Top cover (see Top cover on page 86)

f. Speaker assembly (see Speaker assembly on page 91)

Remove the modem module:

1. Disconnect the modem module cable (1) from the modem module.

2. Remove the two Phillips PM2.5×4.0 screws (2) that secure the modem module to the system
board.
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3. Lift the modem module (3) straight up to disconnect it from the system board.

4. Remove the modem module.

Reverse this procedure to install the modem module.

Modem module cable
NOTE: The modem module cable is included in the Cable Kit, spare part number 596040-001.

Before removing the modem module cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47), and then remove the following components:

a. Optical drive (see Optical drive on page 54) or secondary hard drive (see Secondary hard
drive on page 55)

b. Keyboard (see Keyboard on page 63)

c. Switch cover (see Switch cover on page 67)

d. Display assembly (see Display assembly on page 76)

e. Top cover (see Top cover on page 86)

f. Speaker assembly (see Speaker assembly on page 91)
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Remove the modem module cable:

1. Disconnect the modem module cable (1) from the modem module.

2. Release the modem module cable from the clips (2) and routing channel built into the base
enclosure.

3. Release the RJ-11 jack (3) from the clip built into the base enclosure.

4. Remove the modem module cable.

Reverse this procedure to install the modem module and the modem module cable.

USB board

Description Spare part number

USB board 597572-001

Before removing the USB board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47), and then remove the following components:

a. Optical drive (see Optical drive on page 54) or secondary hard drive (see Secondary hard
drive on page 55)

b. Keyboard (see Keyboard on page 63)

c. Switch cover (see Switch cover on page 67)
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d. Display assembly (see Display assembly on page 76)

e. Top cover (see Top cover on page 86)

Remove the USB board:

1. Remove the Phillips PM2.5×4.0 screw (1) that secures the USB board to the system board.

2. Lift the left side of the USB board (2) to disconnect it from the system board.

3. Lift the USB board (3) straight up and remove it.

4. Remove the USB board.

Reverse this procedure to install the USB board.

Network cable
NOTE: The network cable is included in the Cable Kit, spare part number 596040-001.

Before removing the network cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47), and then remove the following components:

a. Optical drive (see Optical drive on page 54) or secondary hard drive (see Secondary hard
drive on page 55)

b. Keyboard (see Keyboard on page 63)

c. Switch cover (see Switch cover on page 67)
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d. Display assembly (see Display assembly on page 76)

e. Top cover (see Top cover on page 86)

Remove the network cable:

1. Disconnect the network cable (1) from the system board.

2. Release the network cable from the clips (2) built into the base enclosure.

3. Release the network cable ferrite (3) from the clip built into the base enclosure.

4. Release the RJ-45 jack (4) from the clip built into the base enclosure.

5. Remove the network cable.

Reverse this procedure to install the network cable.

System board

Description Spare part number

For use in all countries and regions except the People's Republic of China and Russia:

● For use with computer models equipped with Intel Quad Core processors 595700-001

● For use with computer models equipped with Intel Dual Core processors 595698-001

For use only in the People's Republic of China and Russia:

● For use with computer models equipped with Intel Quad Core processors 598446-001

● For use with computer models equipped with Intel Dual Core processors 598445-001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.
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3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47), and then remove the following components:

a. Primary hard drive (see Primary hard drive on page 49)

b. Optical drive (see Optical drive on page 54) or secondary hard drive (see Secondary hard
drive on page 55)

c. Keyboard (see Keyboard on page 63)

d. Switch cover (see Switch cover on page 67)

e. Graphics board heat sink (see Graphics board heat sink on page 69)

f. Display assembly (see Display assembly on page 76)

g. Top cover (see Top cover on page 86)

h. Audio board (see Audio board on page 90)

i. Speaker (see Speaker assembly on page 91)

j. USB board (see USB board on page 96)

When replacing the system board, be sure that the following additional components are removed
from the defective system board and installed on the replacement system board:

● SIM (see SIM on page 48)

● WLAN module (see WLAN module on page 57)

● WWAN module (see WWAN module on page 59)

● Expansion memory modules (see Expansion memory module on page 60)

● RTC battery (see RTC battery on page 62)

● Primary memory modules (see Primary memory module on page 66)

● Graphics board (see Graphics board on page 72)

● Processor heat sink (see Processor heat sink on page 73)

● Processor (see Processor on page 75)

● Bluetooth module cable (see Bluetooth module cable on page 89)

● Audio cable (see Audio cable on page 93)

● Modem module (see Modem module on page 94)

Remove the system board:

1. Disconnect the network cable (1) from the system board.

2. Press in on the ExpressCard slot bezel (2) to release it from the ExpressCard slot.

3. Remove the ExpressCard slot bezel (3) from the ExpressCard slot.
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4. Remove the two HM5.0×10.0 screw locks (4) that secure the system board to the base
enclosure.

5. Remove the three Phillips PM2.5×4.0 screws (5) that secure the system board to the base
enclosure.

6. Use the optical drive connector (1) to lift the right side of the system board (2) until it rests at an
angle.

7. Release the system board (3) by sliding it up and to the right at an angle.

8. Remove the system board.

Reverse this procedure to install the system board.
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5 Computer Setup

Windows 7
Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating
system is not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup
The information and settings in Computer Setup are accessed from the File, Security, Diagnostics,
and System Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.
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NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.

3. Select the File, Security, or System Configuration menu.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore changes and exit, and then press
enter.

– or –

● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save changes and exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup
NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

3. Use a pointing device or the arrow keys to select File > Restore defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-right corner of the screen, and
then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by
your computer.

File menu

Select To do this

System Information ● View identification information for the computer and the
batteries in the system.

● View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

Set System Date and Time Set or change the date and time on the computer.

System Diagnostics Displays the following information:

● System Information

◦ Identification information for the computer and the
batteries in the system.

◦ Specification information for the processor, cache
and memory size, system ROM, video revision,
and keyboard controller version.

● Start-up Test–Verifies the system components needed
for starting the computer.

● Run-In Test–Runs a comprehensive check on system
memory.

● Hard Disk Test–Runs a comprehensive self-test on any
hard drive in the system.

● Memory Test–Runs a comprehensive test on any
memory installed in the computer.

● Battery Test–Runs a comprehensive test on any
batteries installed in the computer.

● Error Log–Displays a log file if any errors have
occurred.

Restore defaults Replace the configuration settings in Computer Setup with
the original factory settings. (Hard drive mode, password
settings, and security settings are not changed when you
restore the factory settings.)

Reset BIOS security to factory default Restore the BIOS security settings to the factory default.

Ignore changes and exit Cancel any changes entered during the current session.
Then exit and restart the computer.

Save changes and exit Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu
NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Administrator Tools

Setup BIOS Administrator Password Set up a BIOS administrator password

User Management (requires a BIOS administrator password)

Create New BIOS User Account ● Select from a list of BIOS users.

● Select from a list of ProtectTools users.

Password Policy (requires a BIOS administrator password) Revise password policy criteria.

HP SpareKey Enable/disable HP SpareKey (enabled by default).

Always Prompt for HP SpareKey Enrollment Enable/disable HP SpareKey enrollment (enabled by
default).

Fingerprint Reset on Reboot (If Present) Reset/clear the fingerprint reader ownership (select models
only; disabled by default).

User Tools

Change Password Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

Anti Theft

AT-P Enable/disable Anti-Theft Protection.

DriveLock Passwords ● Enable/disable DriveLock on any computer hard drive
(enabled by default).

● Change a DriveLock user password or master
password.

NOTE: DriveLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

Automatic DriveLock Enable/disable Automatic DriveLock support.

TPM Embedded Security Enable/disable support for Trusted Platform Module (TPM)
Embedded Security, which protects the computer from
unauthorized access to owner functions available in
Embedded Security for ProtectTools. For more information,
refer to the ProtectTools software

NOTE: You must have a setup password to change this
setting.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary
hard drive or the drive in the Upgrade bay.

CAUTION: If you run Disk Sanitizer, the data on the
selected drive is destroyed permanently.

System IDs Enter a user-defined computer asset tracking number and
ownership tag.
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System Configuration menu
NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Language Change the Computer Setup language.

Boot Options ● Set a Startup Menu delay (in seconds).

● Set the MultiBook Express Boot Popup delay in
seconds.

● Enable/disable Custom Logo (disabled by default).

● Enable/disable Display Diagnostic URL (enabled by
default).

● Enable/disable CD-ROM boot (disabled by default).

● Enable/disable SD Card boot (enabled by default).

● Enable/disable floppy boot (enabled by default).

● Enable/disable PXE Internal NIC boot (enabled by
default).

● Enable/disable Unified Extensible Firmware Interface
(UEFI) Boot Mode (disabled by default).

● Set the Legacy Boot Order.

Device Configurations ● Enable/disable USB legacy support (enabled by
default). When enabled, USB legacy support allows the
following:

◦ Use of a USB keyboard in Computer Setup even
when a Windows operating system is not running

◦ Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer

● Select a parallel port mode: ECP (Enhanced
Capabilities Port), standard, bidirectional, or EPP
(Enhanced Parallel Port).

● Enable/disable fan always on while connected to an AC
outlet (enabled by default).

● Enable/disable Data Execution Prevention (select
models only). When enabled, the processor can disable
some virus code execution, which helps to improve
computer security (disabled by default).

● SATA (Serial Advanced Technology Attachment) device
mode. The following options are available:

◦ AHCI (Advanced Host Controller Interface)

◦ IDE (Integrated Drive Electronics)

◦ RAID (select models only)

NOTE: Availability of these options varies by
computer model.
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Select To do this

Device Configurations (continued) ● Enable/disable secondary battery fast charge (enabled
by default).

● Enable/disable HP QuickLook (enabled by default).

● Enable/disable Preboot Authentication on HP
QuickLook Boot (enabled by default).

● Enable/disable HP QuickWeb (enabled by default).

● Enable/disable HP QuickWeb Write Protect (disabled by
default).

● Enable/disable Virtualization Technology (select models
only; disabled by default).

● Enable/disable TXT (Intel Trusted Execution
Technology) (select models only; disabled by default).

● Multi Core CPU (enabled by default).

● Intel HT Technology (enabled by default).

● Enable/disable Wake on USB (enabled by default).

● Enable/disable Num lock state at boot (disabled by
default).
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Select To do this

Built-In Device Options ● Enable/disable the wireless button state (enabled by
default).

● Enable/disable embedded WLAN device radio (select
models only; enabled by default).

● Enable/disable the embedded Bluetooth device radio
(enabled by default).

● Enable/disable the Network Interface Controller (LAN)
(enabled by default).

● Enable/disable LAN/WLAN switching (disabled by
default).

● Set the wake on LAN state. Options include the
following:

◦ Disabled

◦ Boot to Network

◦ Follow Boot Order

● Enable/disable the Ambient Light Sensor.

● Enable/disable the Notebook Upgrade bay device
(enabled by default).

● Enable/disable the fingerprint device (enabled by
default).

● Enable/disable the integrated camera (enabled by
default).

● Enable/disable the Power Monitor Circuit (enabled by
default).

● Enable/disable the audio device (enabled by default).

● Enable/disable a modem device (enabled by default).

● Enable/disable the microphone (enabled by default).

● Enable/disable the internal speakers (enabled by
default).
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Select To do this

Port Options NOTE: NOTE: All port options are enabled by default.

● Enable/disable the serial port.

● Enable/disable the parallel port.

● Enable/disable the flash media reader.

● Enable/disable the USB port.

CAUTION: Disabling the USB port also disables
MultiBay devices and ExpressCard devices on the
advanced port replicator.

● Enable/disable the 1394 port.

● Enable/disable the ExpressCard slot.

● Enable/disable the Smart Card slot.

● Enable/disable the eSATA port.

AMT Options ● Enable/disable Firmware Verbosity.

● Enable/disable AMT Setup Prompt (Ctrl-P).

● Enable/disable USB Key Provisioning Support.

● Enable/disable Unconfigure AMT on next boot.

● Select Terminal Emulation Mode.

◦ ANSI

◦ VT100

● Enable/disable Firmware Progress Event Support.

● Enable/disable Initiate Intel CIRA.

Set Security Level Change, view, or hide security levels for all BIOS menu
items.

Restore Security Defaults Restore the default security settings.
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Windows Vista
Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating
system is not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup
The information and settings in Computer Setup are accessed from the File, Security, Diagnostics,
and System Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.

3. Select the File, Security, or System Configuration menu.
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Restoring factory settings in Computer Setup
NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

3. Use a pointing device or the arrow keys to select File > Restore defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-right corner of the screen, and
then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by
your computer.

File menu

Select To do this

System Information ● View identification information for the computer and the
batteries in the system.

● View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

Set System Date and Time Set or change the date and time on the computer.

System Diagnostics Displays the following information:

● System Information

◦ Identification information for the computer and the
batteries in the system.

◦ Specification information for the processor, cache
and memory size, system ROM, video revision,
and keyboard controller version.

● Start-up Test–Verifies the system components needed
for starting the computer.

● Run-In Test–Runs a comprehensive check on system
memory.

● Hard Disk Test–Runs a comprehensive self-test on any
hard drive in the system.

● Memory Test–Runs a comprehensive test on any
memory installed in the computer.

● Battery Test–Runs a comprehensive test on any
batteries installed in the computer.

● Error Log–Displays a log file if any errors have
occurred.

Restore defaults Replace the configuration settings in Computer Setup with
the original factory settings. (Hard drive mode, password
settings, and security settings are not changed when you
restore the factory settings.)

Reset BIOS security to factory default Restore the BIOS security settings to the factory default.

Ignore changes and exit Cancel any changes entered during the current session.
Then exit and restart the computer.

Save changes and exit Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu
NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Administrator Tools

Setup BIOS Administrator Password Set up a BIOS administrator password

User Management (requires a BIOS administrator password)

Create New BIOS User Account ● Select from a list of BIOS users.

● Select from a list of ProtectTools users.

Password Policy (requires a BIOS administrator password) Revise password policy criteria.

HP SpareKey Enable/disable HP SpareKey (enabled by default).

Always Prompt for HP SpareKey Enrollment Enable/disable HP SpareKey enrollment (enabled by
default).

Fingerprint Reset on Reboot (If Present) Reset/clear the fingerprint reader ownership (select models
only; disabled by default).

User Tools

Change Password Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

Anti Theft

AT-P Enable/disable Anti-Theft Protection.

DriveLock Passwords ● Enable/disable DriveLock on any computer hard drive
(enabled by default).

● Change a DriveLock user password or master
password.

NOTE: DriveLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

Automatic DriveLock Enable/disable Automatic DriveLock support.

TPM Embedded Security Enable/disable support for Trusted Platform Module (TPM)
Embedded Security, which protects the computer from
unauthorized access to owner functions available in
Embedded Security for ProtectTools. For more information,
refer to the ProtectTools software

NOTE: You must have a setup password to change this
setting.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary
hard drive or the drive in the Upgrade bay.

CAUTION: If you run Disk Sanitizer, the data on the
selected drive is destroyed permanently.

System IDs Enter a user-defined computer asset tracking number and
ownership tag.
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System Configuration menu
NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Language Change the Computer Setup language.

Boot Options ● Set a Startup Menu delay (in seconds).

● Set the MultiBook Express Boot Popup delay in
seconds.

● Enable/disable Custom Logo (disabled by default).

● Enable/disable Display Diagnostic URL (enabled by
default).

● Enable/disable CD-ROM boot (disabled by default).

● Enable/disable SD Card boot (enabled by default).

● Enable/disable floppy boot (enabled by default).

● Enable/disable PXE Internal NIC boot (enabled by
default).

● Enable/disable Unified Extensible Firmware Interface
(UEFI) Boot Mode (disabled by default).

● Set the Legacy Boot Order.

Device Configurations ● Enable/disable USB legacy support (enabled by
default). When enabled, USB legacy support allows the
following:

◦ Use of a USB keyboard in Computer Setup even
when a Windows operating system is not running

◦ Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer

● Select a parallel port mode: ECP (Enhanced
Capabilities Port), standard, bidirectional, or EPP
(Enhanced Parallel Port).

● Enable/disable fan always on while connected to an AC
outlet (enabled by default).

● Enable/disable Data Execution Prevention (select
models only). When enabled, the processor can disable
some virus code execution, which helps to improve
computer security (disabled by default).

● SATA (Serial Advanced Technology Attachment) device
mode. The following options are available:

◦ AHCI (Advanced Host Controller Interface)

◦ IDE (Integrated Drive Electronics)

◦ RAID (select models only)

NOTE: Availability of these options varies by
computer model.
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Select To do this

Device Configurations (continued) ● Enable/disable secondary battery fast charge (enabled
by default).

● Enable/disable HP QuickLook (enabled by default).

● Enable/disable Preboot Authentication on HP
QuickLook Boot (enabled by default).

● Enable/disable HP QuickWeb (enabled by default).

● Enable/disable HP QuickWeb Write Protect (disabled by
default).

● Enable/disable Virtualization Technology (select models
only; disabled by default).

● Enable/disable TXT (Intel Trusted Execution
Technology) (select models only; disabled by default).

● Multi Core CPU (enabled by default).

● Intel HT Technology (enabled by default).

● Enable/disable Wake on USB (enabled by default).

● Enable/disable Num lock state at boot (disabled by
default).
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Select To do this

Built-In Device Options ● Enable/disable the wireless button state (enabled by
default).

● Enable/disable embedded WLAN device radio (select
models only; enabled by default).

● Enable/disable the embedded Bluetooth device radio
(enabled by default).

● Enable/disable the LAN (enabled by default).

● Enable/disable LAN/WLAN switching (disabled by
default).

● Set the wake on LAN state. Options include the
following:

◦ Disabled

◦ Boot to Network

◦ Follow Boot Order

● Enable/disable the Ambient Light Sensor.

● Enable/disable the Notebook Upgrade bay device
(enabled by default).

● Enable/disable the fingerprint device (enabled by
default).

● Enable/disable the integrated camera (enabled by
default).

● Enable/disable the Power Monitor Circuit (enabled by
default).

● Enable/disable the audio device (enabled by default).

● Enable/disable a modem device (enabled by default).

● Enable/disable the microphone (enabled by default).

● Enable/disable the internal speakers (enabled by
default).
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Select To do this

Port Options NOTE: NOTE: All port options are enabled by default.

● Enable/disable the serial port.

● Enable/disable the parallel port.

● Enable/disable the flash media reader.

● Enable/disable the USB port.

CAUTION: Disabling the USB port also disables
MultiBay devices and ExpressCard devices on the
advanced port replicator.

● Enable/disable the 1394 port.

● Enable/disable the ExpressCard slot.

● Enable/disable the Smart Card slot.

● Enable/disable the eSATA port.

AMT Options ● Enable/disable Firmware Verbosity.

● Enable/disable AMT Setup Prompt (Ctrl-P).

● Enable/disable USB Key Provisioning Support.

● Enable/disable Unconfigure AMT on next boot.

● Select Terminal Emulation Mode.

◦ ANSI

◦ VT100

● Enable/disable Firmware Progress Event Support.

● Enable/disable Initiate Intel CIRA.

Set Security Level Change, view, or hide security levels for all BIOS menu
items.

Restore Security Defaults Restore the default security settings.
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Windows XP
Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating
system is not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup
The information and settings in Computer Setup are accessed from the File, Security, Diagnostics,
and System Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.

3. Select the File, Security, or System Configuration menu.
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To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore changes and exit, and then press
enter.

– or –

● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save changes and exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup
NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

3. Use a pointing device or the arrow keys to select File > Restore defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-right corner of the screen, and
then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by
your computer.

File menu

Select To do this

System Information ● View identification information for the computer and the
batteries in the system.

● View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

Set System Date and Time Set or change the date and time on the computer.

System Diagnostics Displays the following information:

● System Information

◦ Identification information for the computer and the
batteries in the system.

◦ Specification information for the processor, cache
and memory size, system ROM, video revision,
and keyboard controller version.

● Start-up Test–Verifies the system components needed
for starting the computer.

● Run-In Test–Runs a comprehensive check on system
memory.

● Hard Disk Test–Runs a comprehensive self-test on any
hard drive in the system.

● Memory Test–Runs a comprehensive test on any
memory installed in the computer.

● Battery Test–Runs a comprehensive test on any
batteries installed in the computer.

● Error Log–Displays a log file if any errors have
occurred.

Restore defaults Replace the configuration settings in Computer Setup with
the original factory settings. (Hard drive mode, password
settings, and security settings are not changed when you
restore the factory settings.)

Reset BIOS security to factory default Restore the BIOS security settings to the factory default.

Ignore changes and exit Cancel any changes entered during the current session.
Then exit and restart the computer.

Save changes and exit Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu
NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Administrator Tools

Setup BIOS Administrator Password Set up a BIOS administrator password

User Management (requires a BIOS administrator password)

Create New BIOS User Account ● Select from a list of BIOS users.

● Select from a list of ProtectTools users.

Password Policy (requires a BIOS administrator password) Revise password policy criteria.

HP SpareKey Enable/disable HP SpareKey (enabled by default).

Always Prompt for HP SpareKey Enrollment Enable/disable HP SpareKey enrollment (enabled by
default).

Fingerprint Reset on Reboot (If Present) Reset/clear the fingerprint reader ownership (select models
only; disabled by default).

User Tools

Change Password Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

Anti Theft

AT-P Enable/disable Anti-Theft Protection.

DriveLock Passwords ● Enable/disable DriveLock on any computer hard drive
(enabled by default).

● Change a DriveLock user password or master
password.

NOTE: DriveLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

Automatic DriveLock Enable/disable Automatic DriveLock support.

TPM Embedded Security Enable/disable support for Trusted Platform Module (TPM)
Embedded Security, which protects the computer from
unauthorized access to owner functions available in
Embedded Security for ProtectTools. For more information,
refer to the ProtectTools software

NOTE: You must have a setup password to change this
setting.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary
hard drive or the drive in the Upgrade bay.

CAUTION: If you run Disk Sanitizer, the data on the
selected drive is destroyed permanently.

System IDs Enter a user-defined computer asset tracking number and
ownership tag.
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System Configuration menu
NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Language Change the Computer Setup language.

Boot Options ● Set a Startup Menu delay (in seconds).

● Set the MultiBook Express Boot Popup delay in
seconds.

● Enable/disable Custom Logo (disabled by default).

● Enable/disable Display Diagnostic URL (enabled by
default).

● Enable/disable CD-ROM boot (disabled by default).

● Enable/disable SD Card boot (enabled by default).

● Enable/disable floppy boot (enabled by default).

● Enable/disable PXE Internal NIC boot (enabled by
default).

● Enable/disable Unified Extensible Firmware Interface
(UEFI) Boot Mode (disabled by default).

● Set the Legacy Boot Order.

Device Configurations ● Enable/disable USB legacy support (enabled by
default). When enabled, USB legacy support allows the
following:

◦ Use of a USB keyboard in Computer Setup even
when a Windows operating system is not running

◦ Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer

● Select a parallel port mode: ECP (Enhanced
Capabilities Port), standard, bidirectional, or EPP
(Enhanced Parallel Port).

● Enable/disable fan always on while connected to an AC
outlet (enabled by default).

● Enable/disable Data Execution Prevention (select
models only). When enabled, the processor can disable
some virus code execution, which helps to improve
computer security (disabled by default).

● SATA (Serial Advanced Technology Attachment) device
mode. The following options are available:

◦ AHCI (Advanced Host Controller Interface)

◦ IDE (Integrated Drive Electronics)

◦ RAID (select models only)

NOTE: Availability of these options varies by
computer model.
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Select To do this

Device Configurations (continued) ● Enable/disable secondary battery fast charge (enabled
by default).

● Enable/disable HP QuickLook (enabled by default).

● Enable/disable Preboot Authentication on HP
QuickLook Boot (enabled by default).

● Enable/disable HP QuickWeb (enabled by default).

● Enable/disable HP QuickWeb Write Protect (disabled by
default).

● Enable/disable Virtualization Technology (select models
only; disabled by default).

● Enable/disable TXT (Intel Trusted Execution
Technology) (select models only; disabled by default).

● Multi Core CPU (enabled by default).

● Intel HT Technology (enabled by default).

● Enable/disable Wake on USB (enabled by default).

● Enable/disable Num lock state at boot (disabled by
default).
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Select To do this

Built-In Device Options ● Enable/disable the wireless button state (enabled by
default).

● Enable/disable embedded WLAN device radio (select
models only; enabled by default).

● Enable/disable the embedded Bluetooth device radio
(enabled by default).

● Enable/disable the LAN (enabled by default).

● Enable/disable LAN/WLAN switching (disabled by
default).

● Set the wake on LAN state. Options include the
following:

◦ Disabled

◦ Boot to Network

◦ Follow Boot Order

● Enable/disable the Ambient Light Sensor.

● Enable/disable the Notebook Upgrade bay device
(enabled by default).

● Enable/disable the fingerprint device (enabled by
default).

● Enable/disable the integrated camera (enabled by
default).

● Enable/disable the Power Monitor Circuit (enabled by
default).

● Enable/disable the audio device (enabled by default).

● Enable/disable a modem device (enabled by default).

● Enable/disable the microphone (enabled by default).

● Enable/disable the internal speakers (enabled by
default).
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Select To do this

Port Options NOTE: NOTE: All port options are enabled by default.

● Enable/disable the serial port.

● Enable/disable the parallel port.

● Enable/disable the flash media reader.

● Enable/disable the USB port.

CAUTION: Disabling the USB port also disables
MultiBay devices and ExpressCard devices on the
advanced port replicator.

● Enable/disable the 1394 port.

● Enable/disable the ExpressCard slot.

● Enable/disable the Smart Card slot.

● Enable/disable the eSATA port.

AMT Options ● Enable/disable Firmware Verbosity.

● Enable/disable AMT Setup Prompt (Ctrl-P).

● Enable/disable USB Key Provisioning Support.

● Enable/disable Unconfigure AMT on next boot.

● Select Terminal Emulation Mode.

◦ ANSI

◦ VT100

● Enable/disable Firmware Progress Event Support.

● Enable/disable Initiate Intel CIRA.

Set Security Level Change, view, or hide security levels for all BIOS menu
items.

Restore Security Defaults Restore the default security settings.
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6 Specifications

Computer specifications
 Metric U.S.

Dimensions

Width 39.75 cm 15.64 in

Depth 28.55 cm 11.24 in

Height (front to back) 3.65 cm to 4.16 cm 1.44 in to 1.64 in

Weight 3.365 kg 7.42 lbs

Input power

Operating voltage 19.0 V dc @ 4.74 A – 120 W

Operating current 4.74 A

Temperature

Operating (not writing to optical disc) 0°C to 35°C 32°F to 95°F

Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity

Operating 10% to 90%

Nonoperating 5% to 90%

Maximum altitude (unpressurized)

Operating (14.7 to 10.1 psia) -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating (14.7 to 4.4 psia) -15 m to 12,192 m -50 ft to 40,000 ft

Shock

Operating 125 g, 2 ms, half-sine

Nonoperating 200 g, 2 ms, half-sine

Random vibration

Operating 0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate
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 Metric U.S.

Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within
this range of temperatures.

17.0-inch, WUXGA WVA display specifications
 Metric U.S.

Dimensions

Width 24.4 cm 9.65 in

Depth 38.1 cm 15.0 in

Diagonal 43.2 cm 17.0 in

Number of colors Up to 16.8 million

Contrast ratio 200:1 (typical)

Brightness 180 nits (typical)

Backlight LED

Character display 80 × 25

Total power consumption 6.0 W

Viewing angle +/-65 horizontal, +/-50° vertical (typical)
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Hard drive specifications
 640-GB* 500-GB* 320-GB* 250-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm

Width 70 mm 70 mm 70 mm 70 mm

Weight 101 g 101 g 101 g 101 g

Interface type SATA SATA SATA SATA

Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 3 ms 3 ms 3 ms 3 ms

Average 13 ms 13 ms 13 ms 13 ms

Maximum 24 ms 24 ms 24 ms 24 ms

Logical blocks 1,250,242,867 976,752,240 625,121.433 488,376,120

Disk rotational speed 7200 rpm 7200 rpm 7200 rpm 7200 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive
specifications

Applicable disc Read: Write:

 BD-ROM, BD-ROM-DL, BD-R, BD-R-
DL, BD-RE, BD-RE-DL, DVD-ROM,
DVD+R, DVD+R-DL, DVD+RW, DVD-
R, DVD-R-DL, DVD-RW, DVD-RAM
(Ver.2), CD-DA, CD-ROM (mode 1 and
mode 2), CD-ROM XA (mode 2, form 1
and form 2), Photo CD (single and
multiple sessions), CD Extra, CD-R,
CD-RW, and CD-TEXT

DVD-RAM (Ver.2), DVD+R, DVD-R,
CD-R, and CD-ROM

Access time BD DVD

Random < 230 ms < 180 ms

Cache buffer 4.5 MB

Data transfer rate

2X BD-RAM 9 MB/sec

8X DVD 2,400 KB/sec

16X CD-R 2,400 KB/sec

16X CD-RW 2,400 KB/sec
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DVD±RW SuperMulti Double-Layer LightScribe Drive
specifications

Applicable disc Read: Write:

 CD-DA, CD+(E)G, CD-MIDI, CD-TEXT,
CD-ROM, CD-ROM XA, MIXED MODE
CD, CD-I, CD-I Bridge (Photo-CD,
Video CD), Multisession CD, CD-
EXTRA, Portfolio, CD-R, CD-RW), CD-
R, CD-RW, DVD-ROM (DVD-5, DVD-9,
DVD-10, DVD-18), DVD-R, DVD-RW,
DVD+R, DVD+RW, DVD-RAM

CD-R and CD-RW

DVD+R, DVD+RW, DVD-R, DVD-RW,
DVD-RAM

Access time CD DVD

Random < 175 ms < 230 ms

Cache buffer 2.5 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

Transfer mode Multiword DMA Mode
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DVD-ROM Drive specifications
Applicable disc Read: Write:

 CD-DA, CD+(E)G, CD-MIDI, CD-TEXT,
CD-ROM, CD-ROM XA, MIXED MODE
CD, CD-I, CD-I Bridge (Photo-CD,
Video CD), Multisession CD (Photo-CD,
CDEXTRA, Portfolio, CD-R, CD-RW),
CDR, CD-RW, DVD-ROM (DVD-5,
DVD-9, DVD-10, DVD-18), DVD-R,
DVD-RW, DVD+R, DVD+RW, DVD-
RAM

CD-R and CD-RW

Access time CD DVD

Random < 110 ms < 130 ms

Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 3,600 KB/sec
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7 Backup and recovery

Windows 7
To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive (select models only), create system repair discs (select models only),
or create system restore points. In case of system failure, you can use the backup files to restore the
contents of your computer.

Windows Backup and Restore provides the following options:

● Creating a system repair disc (select models only)

● Backing up individual files and folders

● Creating a system image (select models only)

● Scheduling automatic backups (select models only)

● Creating system restore points

● Recovering individual files

● Restoring the computer to a previous state

● Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.
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Backing up your information
Recovery after a system failure is as complete as your most current backup. You should create
system repair discs (select models only) and your initial backup immediately after software setup. As
you add new software and data files, you should continue to back up your system on a regular basis
to maintain a reasonably current backup. The system repair discs (select models only) are used to
start up (boot) the computer and repair the operating system in case of system instability or failure.
Your initial and subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.

The screen image is added to the document.

4. Save the document.

● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend
on the type of optical drive installed in your computer.

NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

● When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

To create a backup using Backup and Restore, follow these steps:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.
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NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create a system repair disc (select models only).

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
discs you previously created (select models only), you must purchase a Windows 7 operating system
DVD to reboot the computer and repair the operating system. For additional information, refer to the
“Using a Windows 7 operating system DVD (purchased separately)” section in this guide.

Using the Windows recovery tools
To recover information you previously backed up, follow these steps:

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to recover your system settings, your computer (select models
only), or your files.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

To recover your information using Startup Repair, follow these steps:
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CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently
removed. When reformatting is complete, the recovery process restores the operating system, as well
as the drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition or the HP Recovery partition.

To check for the Windows partition, select Start > Computer.

To check for the HP Recovery partition, click Start, right-click Computer, click Manage, and
then click Disk Management.

NOTE: If the Windows partition or the HP Recovery partition is not listed, you must recover
your operating system and programs using the Windows 7 operating system DVD and the Driver
Recovery disc (both purchased separately). For additional information, refer to the “Using a
Windows 7 operating system DVD (purchased separately)” section.

3. If the Windows partition and the HP Recovery partition are listed, restart the computer, and then
press f8 before the Windows operating system loads.

4. Select Startup Repair.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.

Using f11 recovery tools
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The f11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled. Personal files must be restored from
a backup.

To recover the original hard drive image using f11, follow these steps:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: click Start, right-click
Computer, click Manage, and then click Disk Management.

NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 7 operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, refer to the “Using a Windows 7 operating
system DVD (purchased separately)” section.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press
the ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.
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Using a Windows 7 operating system DVD (purchased separately)
If you are unable to boot (start up) your computer and you cannot use the system repair discs you
previously created (select models only), you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system. Be sure that your most recent backup (stored
on discs or on an external drive) is easily accessible. To order a Windows 7 operating system DVD,
go to http://www.hp.com/support, select your country or region, and follow the on-screen instructions.
You can also order the DVD by calling technical support. For contact information, refer to the
Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD, follow these steps:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical
drive before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.
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Windows Vista
To protect your information, use the Backup and Restore Center to back up individual files and
folders, back up your entire hard drive (select models only), or create system restore points. In case
of system failure, you can use the backup files to restore the contents of your computer.

The Backup and Restore Center provides the following options:

● Backing up individual files and folders

● Backing up the entire hard drive (select models only)

● Scheduling automatic backups (select models only)

● Creating system restore points

● Recovering individual files

● Restoring the computer to a previous state

● Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.

Backing up your information
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

● Store personal files in the Documents folder, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.
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3. Open a word-processing document, and then select Edit > Paste.

The screen image is added to the document.

4. Save the document.

● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend
on the type of optical drive installed in your computer.

NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

● When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to back up your entire computer (select models only) or your
files.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use the Backup and Restore Center to recover information
you have previously backed up. You can also use Windows Startup Repair to fix problems that
might prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

NOTE: If you are unable to boot (start up) your computer, you must purchase a Windows Vista
operating system DVD to reboot the computer and repair the operating system. For additional
information, refer to the “Using a Windows Vista operating system DVD (purchased separately)”
section in this guide.
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Using the Windows recovery tools
To recover information you previously backed up, follow these steps:

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to recover your entire computer (select models only) or your
files.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

To recover your information using Startup Repair, follow these steps:

CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently
removed. When reformatting is complete, the recovery process restores the operating system, as well
as the drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition or the HP Recovery partition. To find
the partitions, select Start > Computer.

NOTE: If the Windows partition and the HP Recovery partition have been deleted, you must
recover your operating system and programs using the Windows Vista operating system DVD
and the Driver Recovery disc (both purchased separately). For additional information, refer to
the “Using a Windows Vista operating system DVD (purchased separately)” section.

3. Restart the computer, and then press f8 before the Windows operating system loads.

4. Select Repair your computer.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.
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Using f11 recovery tools
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The f11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled. Personal files must be restored from
a backup.

NOTE: If your computer includes a solid-state drive (SSD), you may not have a recovery partition.
Recovery discs have been included for computers that do not have a partition. Use these discs to
recover your operating system and software. To check for the presence of a recovery partition, select
Start > Computer. If the partition is present, an HP Recovery drive is listed in the Hard Disk Drives
section of the window.

To recover the original hard drive image using f11, follow these steps:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. To find the partition, select
Start > Computer.

NOTE: If the HP Recovery partition has been deleted, you must recover your operating system
and programs using the Windows Vista operating system DVD and the Driver Recovery disc
(both purchased separately). For additional information, refer to the “Using a Windows Vista
operating system DVD (purchased separately)” section.

3. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.
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Using a Windows Vista operating system DVD (purchased separately)
If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating
system DVD to reboot the computer and repair the operating system. Be sure that your most recent
backup (stored on discs or on an external drive) is easily accessible. To order a Windows Vista
operating system DVD, go to http://www.hp.com/support, select your country or region, and follow the
on-screen instructions. You can also order the DVD by calling technical support. For contact
information, refer to the Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents
and reformats the hard drive. All files you have created and any software installed on the computer
are permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows Vista operating system DVD, follow these steps:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows Vista operating system DVD into the optical
drive before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.
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Windows XP
To protect your information, use the Windows Backup utility to back up files and folders or create
recovery points. In case of system failure, you can use the backup files to restore your computer.

Windows provides the following options:

● Backing up individual files and folders

● Backing up all files and folders

● Scheduling automatic backups

● Creating recovery points

● Recovering information

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.

Backing up your information
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up individual files or folders to an optional external hard drive or to a network drive.

Note the following when backing up:

● Store personal files in the My Documents folder, and back it up periodically.

● Back up templates stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.

The screen image is added to the document.

4. Save the document.

To create a backup using the Windows Backup utility (select models only), follow these steps:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

Windows XP 141



NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Accessories > System Tools > Backup.

2. Follow the on-screen instructions.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools (select models only): You can use the Windows Backup utility to recover
information you have previously backed up.

● Operating System and Driver Recovery discs (included with your computer): You can use the
discs to recover your operating system and programs installed at the factory.

Recovering your information
To recover information you previously backed up, follow these steps:

1. If possible, back up all personal files.

2. Select Start > All Programs > Accessories > System Tools > Backup.

The Backup or Restore Wizard opens.

3. Click Restore files and settings, and then click Next.

4. Follow the on-screen instructions.

NOTE: For additional information on initiating a recovery in Windows, perform a search for this topic
in Help and Support.

Recovering the operating system and programs
CAUTION: The recovery process reformats and completely erases the hard drive. All files you have
created and any software installed on the computer are permanently removed. The recovery process
reinstalls the original operating system as well as software and drivers. Software, drivers, and
updates not installed by HP must be manually reinstalled. Personal files must be restored from a
backup.

To recover your operating system and programs, follow these steps:

1. If possible, back up all personal files.

2. Shut down the computer.

3. Insert the Operating System disc into the optical drive.

4. Turn on the computer.

5. Follow the on-screen instructions to install the operating system.

6. After the operating system is installed, remove the Operating System disc and insert the Driver
Recovery disc.

7. Follow the on-screen instructions to install the drivers and programs.
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8 Connector pin assignments

1394

Pin Signal

1 TPB-

2 TPB+

3 TPA-

4 TPA+

Audio-in (microphone)

Pin Signal

1 Audio signal in

2 Audio signal in

3 Ground
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Audio-out (headphone)

Pin Signal

1 Audio out, left channel

2 Audio out, right channel

3 Ground

DisplayPort

Pin Signal

1 ML_lane 0 (positive)

2 Ground

3 Lane 0 (negative)

4 Lane 1 (positive)

5 Ground

6 Lane 1 (negative)

7 Lane 2 (positive)

8 Ground

9 Lane 2 (negative)

10 Lane 3 (positive)

11 Ground

12 Lane 3 (negative)

13 Connectecd to ground

14 Connected to ground

15 Auxiliary channel (positive)
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Pin Signal

16 Ground

17 Auxiliary channel

18 Hot plug detect

19 Return for power

20 Power for connector

External monitor

Pin Signal

1 Red analog

2 Green analog

3 Blue analog

4 Not connected

5 Ground

6 Ground analog

7 Ground analog

8 Ground analog

9 +5 VDC

10 Ground

11 Monitor detect

12 DDC 2B data

13 Horizontal sync

14 Vertical sync

15 DDC 2B clock
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RJ-11 (modem)

Pin Signal

1 Unused

2 Tip

3 Ring

4 Unused

5 Unused

6 Unused
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RJ-45 (network)

Pin Signal

1 Transmit +

2 Transmit -

3 Receive +

4 Unused

5 Unused

6 Receive -

7 Unused

8 Unused

Universal Serial Bus

Pin Signal

1 +5 VDC

2 Data

3 Data +

4 Ground

RJ-45 (network) 147



9 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries
The following requirements are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions
Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China COC 5

South Korea EK 4

Sweden SEMKO 1

Switzlerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region
where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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10 Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Caution must be exercised when removing and
handling the backlight to avoid damaging this component and causing exposure to the mercury.

CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the
backlight. When you remove these components, handle them carefully.

NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display
assembly that might require special handling at end-of-life. Disposal of mercury may be regulated
because of environmental considerations. For disposal or recycling information, contact your local
authorities, or see the Electronic Industries Alliance (EIA) Web site at http://www.eiai.org.

This section provides disassembly instructions for the display assembly. The display assembly must
be disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this chapter are general disassembly instructions. Specific
details, such as screw sizes, quantities, and locations, and component shapes and sizes, can vary
from one computer model to another.
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Perform the following steps:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display
assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel 3.
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter 2.

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the
display panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.

14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.

17. Remove the backlight frame from the display panel.

WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

18. Remove the backlight from the backlight frame.
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19. Disconnect the display cable (1) from the LCD panel.

20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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Symbols/Numerics
1394 port

connector pinout 143
location 15

A
AC adapter, spare part number

32, 38
accessory battery connector 17
ambient light sensor board

removal 81
spare part number 28, 35, 81

antenna
locations 8
removal 84
spare part number 28, 34, 84,

85
audio board

removal 90
spare part number 24, 35, 90

audio cable
illustrated 26
removal 93

audio, product description 3
audio-in jack

connector pinout 143
location 14

audio-out jack
connector pinout 144
location 14

B
base enclosure, spare part

number 25, 35
battery

removal 47
spare part numbers 25, 33,

34, 47
battery bay 16

battery light 13
battery release latch 16
Blu-ray R/RE DVD±RW SuperMulti

Double-Layer Drive
precautions 41
removal 54
spare part number 25, 29, 38,

54
specifications 128

Blu-ray ROM DVD±RW SuperMulti
Double-Layer LightScribe Drive

removal 54
spare part numbers 25, 30,

38, 54
Bluetooth module

removal 52
spare part number 25, 33, 52

Bluetooth module cable
illustrated 26
removal 89

Bluetooth module compartment
16

Bluetooth module compartment
cover

illustrated 31
removal 52

bottom components 16
business card slot 13
button components 9
buttons

calculator 10
caps lock 10
num lock 10
pointing stick 12
power 9
QuickLook 10
QuickWeb 10
TouchPad 10, 12
volume down 10

volume mute 10
volume up 10
wireless 10

C
Cable Kit

contents 26
spare part number 23, 26, 34

cables, service considerations 41
calculator button 10
caps lock button 10
chipset, product description 1
components

antenna 8
bottom 16
buttons 9
display 7
front 13
keys 11
left-side 15
pointing device 12
rear 15
right-side 14
switches 9
wireless antenna 8

computer feet, locations 46
computer part number 18, 45
computer specifications 125
connector pinout

1394 port 143
audio-in jack 143
audio-out jack 144
DisplayPort 144
external monitor port 145
headphone jack 144
microphone jack 143
modem jack 146
monitor port 145
network jack 147
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RJ-11 jack 146
RJ-45 jack 147
Universal Serial Bus (USB)

port 147
connectors, service

considerations 41

D
diskette drive

precautions 41
product description 3

display assembly
removal 76
spare part numbers 21, 34, 76

display bezel
removal 80
spare part numbers 27, 35, 81

display components 7
display enclosure, spare part

number 28, 35
Display Hinge Kit, spare part

number 28, 35
display panel cable

removal 83
spare part number 28, 35, 84

display panel, product
description 2

display release button 14
Display Rubber Kit, spare part

number 28, 35
Display Screw Kit, spare part

number 28, 35
display specifications 126
display switch 7, 10
DisplayPort 15

connector pinout 144
docking connector 16
docking support, product

description 5
drive light 13
drives, preventing damage 41
DVD-ROM Drive

precautions 41
removal 54
spare part number 25, 30, 38,

54
specifications 130

DVD±RW and CD-RW SuperMulti
Double-Layer Combo Drive

precautions 41
specifications 129

DVD±RW SuperMulti Double-
Layer LightScribe Drive

removal 54
spare part numbers 25, 29,

38, 54
specifications 129

E
electrostatic discharge 42
eSATA port 14
esc key 11
Ethernet, product description 3
ExpressCard slot 15
ExpressCard slot bezel,

illustrated 31
external media cards, product

description 4
external monitor port

connector pinout 145
location 15

F
fan

removal 71
spare part number 23, 35, 71

feet, locations 46
fingerprint reader 10
fn key 11
front components 13
function key 11

G
graphics board

removal 72
spare part numbers 23, 35, 72

graphics, product description 1
grounding equipment and

methods 44

H
hard drive

precautions 41
product description 2
removal 49, 55
spare part numbers 25, 29,

33, 38, 39, 49, 55
specifications 127

hard drive bay 16
hard drive bracket, removal 51
hard drive carrier

removal 55
spare part number 25, 29, 38,

55
hard drive cover

illustrated 31
removal 50

Hard Drive Hardware Kit, spare
part number 32, 39

headphone jack
connector pinout 144
location 14

heat sink
removal 69, 73
spare part numbers 23, 35,

69, 73
hinge

illustrated 28
removal 82
spare part number 28, 35, 83

hinge cover
illustrated 28
removal 82

J
jacks

audio-in 14
audio-out 14
headphone 14
microphone 14
modem 14
network 14
RJ-11 14
RJ-45 14

K
key components 11
keyboard

product description 5
removal 63
spare part numbers 21, 22,

35, 36, 37, 38, 63
keypad key 11
keys

esc 11
fn 11
function 11
keypad 11
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Windows applications 11
Windows logo 11

L
left-side components 15
lights

battery 13
drive 13
power 13
webcam 8
wireless 13

M
mass storage device, spare part

numbers 25, 29
Media Card Reader 14
memory module

product description 2
removal 60, 66
spare part numbers 23, 38,

39, 60, 66
memory module/wireless module

compartment 16
memory module/wireless module

compartment cover
illustrated 31
removal 58

microphone
locations 7
product description 3
removal 85
spare part number 27, 35, 86

microphone jack
connector pinout 143
location 14

model description 19, 45
model name 1
modem jack

connector pinout 146
location 14

modem module
product description 3
removal 94
spare part numbers 24, 33, 94

modem module cable
illustrated 26
removal 95

monitor port
connector pinout 145
location 15

N
network cable

illustrated 26
removal 97

network jack
connector pinout 147
location 14

num lock button 10

O
operating system, product

description 6
optical drive

precautions 41
product description 3
removal 54
spare part numbers 25, 29,

38, 54
specifications 128, 129, 130

P
packing guidelines 43
plastic parts 40
Plastics Kit

contents 31
spare part number 23, 31, 35

pointing device
components 12
product description 5

pointing stick 12
pointing stick button 12
ports

1394 15
eSATA 14
external monitor 15
monitor 15
product description 5
Universal Serial Bus (USB)

14, 15
power button 9
power connector 15
power cord

set requirements 148
spare part numbers 32, 33

power light 13
power requirements, product

description 5
processor

product description 1

removal 75
spare part numbers 24, 34, 75

product description
audio 3
chipset 1
diskette drive 3
display panel 2
docking support 5
Ethernet 3
external media cards 4
graphics 1
hard drives 2
keyboard 5
memory module 2
microphone 3
modem module 3
operating system 6
optical drives 3
pointing devices 5
ports 5
power requirements 5
processors 1
product name 1
security 5
solid state drive 2
Upgrade bay 3
video 3
wireless 4

product name 1, 18, 45
product number 18, 45

Q
QuickLook button 10
QuickWeb button 10

R
rear component 15
removal/replacement

preliminaries 40
procedures 45

right-side components 14
RJ-11 jack

connector pinout 146
location 14

RJ-45 jack
connector pinout 147
location 14

RTC battery
removal 62
spare part number 25, 33, 62
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S
Screw Kit, spare part number 32,

34
security cable slot 15
security, product description 5
serial number 18, 45
service considerations 40
service tag 18, 45
SIM slot 17
SIM, removal 48
Smart Card reader 15

spare part number 35
solid-state drive

precautions 41
product description 2
removal 49
spare part number 25, 29, 35,

49
speaker assembly

removal 91
spare part number 24, 33, 91

speakers 13
specifications

Blu-ray R/RE DVD±RW
SuperMulti Double-Layer
Drive 128

computer 125
display 126
DVD-ROM Drive 130
DVD±RW SuperMulti Double-

Layer LightScribe Drive 129
hard drive 127
optical drive 128, 129, 130

static-shielding materials 44
switch components 9
switch cover

removal 67
spare part number 21, 35, 67

system board
removal 98
spare part numbers 24, 34,

38, 98

T
tools required 40
top cover

removal 86
spare part number 24, 35, 86

TouchPad 12
TouchPad button 10, 12

TouchPad scroll zone 12
transporting guidelines 43

U
Universal Serial Bus (USB) port

connector pinout 147
location 14, 15

Upgrade bay
location 14
product description 3

USB board
removal 96
spare part number 24, 35, 96

V
vents 15, 16
video, product description 3
volume down button 10
volume mute button 10
volume up button 10

W
warranty period 19, 45
webcam light 8
webcam module

removal 85
spare part number 27, 35, 85

webcam, location 8
Windows applications key 11
Windows logo key 11
wireless antenna

locations 8
removal 84
spare part number 28, 34, 84,

85
Wireless Antenna Kit, spare part

number 84, 85
wireless button 10
wireless light 13
wireless, product description 4
WLAN module

removal 57
spare part numbers 25, 33, 57

workstation guidelines 43
WWAN module

removal 59
spare part numbers 25, 33,

34, 59
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